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Introductory Note
ColorGenius EX (hereafter referred to as the “ColorGenius”) handles RGB or Grayscale images input

from color scanners, or other devices, and processes them to obtain the optimum image data for

printing.

This product is designed and manufactured solely for the above objective and should not be used for

any other purpose.  If this software is utilized for purposes or uses other than those described above,

we shall bear absolutely no liability or responsibility for the consequences. This Users Manual

describes the functions of each command and their actual operations.  Before you use the

ColorGenius, thoroughly read and understand this manual.  Also place this manual nearby so that you

can refer to it whenever necessary.

This manual contains the following sections:

Chapter 1 Introduction to ColorGenius

This chapter describes an outline of the functions in ColorGenius and the procedures for installing

ColorGenius, and explains general concepts necessary when handling digital images.

Chapter 2 Operation environmental settings

ColorGenius can be implemented in either of the following three environments: a client/server

environment in which the FT-S5500 is connected to two computers  (a client and a server), a multi-

client/server environment in which multiple clients are connected to one server, and a standalone

environment in which a single computer is used.  The first part of this chapter illustrates the setting

procedures for the network needed when implementing the ColorGenius in the client/server

environment with the FT-S5500 or the multi-client/server environment.  The latter part of this

chapter describes the default setups and calibration settings of ColorGenius necessary in both

standalone and client/server environments.

Chapter 3 Understanding basic setup procedures

This chapter explains the fine adjustment procedures for images using Easy Setup in both the

standalone and client/server environments.

With the Manual Setup, you can make precise parameter settings (types and values) for setup

commands to achieve a refined-touch image processing.  This chapter explains the commands and

tools and their available usage in the Manual fine adjustment.
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Chapter 4 Utilizing convenient functions

This chapter explains the usage of various customizing functions, and the “recall previous setup”

command, which is useful if you want to reuse the previous setup parameters.  It also explains the

setup procedure using the optional compound tray.

Chapter 5 Make Profile Tools

Make Profile Tools is an utility software to create profiles which are used when ColorGenius inputs

or outputs images from/to other devices.  This chapter explains how to use ColorGenius Tools.

Chapter 6 Line Art Input

ColorGenius allows you to input line art images in either transparent media or reflective media from

the FT-S5500.  This chapter explains the procedure for inputting line art images from the FT-

S5500.

Note • This manual is basically intended for those using Mac OS 9.1. Those using Mac

OS X require some different instructions and those instructions will be written

additionally.

• This manual is basically intended for those using FT-S5500. Those using FT-

S5000 require some different instructions and those instructions will be added.



iv

Contents
Chapter 1  Introduction to ColorGenius ............................................................................ 1-1

1.  What is ColorGenius? ............................................................................................. 1-1

2.  ColorGenius Operating Environment ...................................................................... 1-3

2.1  Client/Server Environment ............................................................................... 1-3

2.2  Multi-client/server environment ........................................................................ 1-6

2.3  A client/server environment within a single computer ...................................... 1-6

2.4  Server assistant ............................................................................................... 1-7

2.5  Standalone Environment ................................................................................. 1-8

3.  Image Types and Resolutions ................................................................................ 1-9

3.1  Color Models.................................................................................................... 1-9

3.2  Pixels and Resolution .................................................................................... 1-12

3.3  Types of originals that can be input ............................................................... 1-13

4.  Installation ............................................................................................................. 1-15

4.1  Cautions to be observed before installation................................................... 1-15

4.2  Installation Procedure .................................................................................... 1-16

Chapter 2 Operation environmental settings .................................................................... 2-1

1.  Client/server environment setup ............................................................................. 2-4

1.1  Server setup .................................................................................................... 2-4

1.2  Client setup .................................................................................................... 2-14

1.3  Linking the client and server computers ........................................................ 2-15

2.  Foreground/background environment ................................................................... 2-17

3.  Multi-client/server environment setup ................................................................... 2-18

3.1  Server setup .................................................................................................. 2-19

3.2  Client setup .................................................................................................... 2-20

3.3  Linking the client and server computers ........................................................ 2-20

4.  Server assistant .................................................................................................... 2-21

4.1  Server assistant setup ................................................................................... 2-22

4.2  Client setup .................................................................................................... 2-28

5.  FT-S5500 setup .................................................................................................... 2-29

6.  ColorGenius default setup .................................................................................... 2-34

6.1  General setup ................................................................................................ 2-34

6.2  Setup environment......................................................................................... 2-37



v

6.3  Setup customize ............................................................................................ 2-39

6.4  Entry key word ............................................................................................... 2-39

7.  Color calibration setup .......................................................................................... 2-40

7.1  About ColorSync ............................................................................................ 2-40

7.2  ColorGenius’s color calibration ...................................................................... 2-44

7.3  Settings of ColorSync .................................................................................... 2-48

8.  Setting for performance improvement .................................................................. 2-56

Chapter 3  Understanding basic setup procedures .......................................................... 3-1

1.  Easy Setup in a client/server environment or a multi-client/server environment .... 3-1

1.1  Starting the program ........................................................................................ 3-1

1.2  Inputting images .............................................................................................. 3-6

1.3  Trimming .......................................................................................................... 3-8

1.4  Setup essentials ............................................................................................ 3-17

1.5  Server registration ......................................................................................... 3-38

2.  Settings for using ColorGenius in a standalone environment ............................... 3-45

2.1  Booting the computer ..................................................................................... 3-45

2.2  Openning an image file .................................................................................. 3-47

2.3  Starting Easy Setup ....................................................................................... 3-48

3.  Fine adjustment with Easy Setup ......................................................................... 3-50

3.1  Opening the “Easy Setup: Fine Adjustment” dialog box ................................ 3-50

3.2  Adjusting the overall contrast and lightness................................................... 3-51

3.3  Correcting colors............................................................................................ 3-51

3.4  Adjusting sharpness....................................................................................... 3-57

3.5  Enlarging/reducing, scrolling and color picking.............................................. 3-59

4.  Manual Fine Adjustment ....................................................................................... 3-60

4.1  Color correction and tone curve (Retouch color, Misc. ) ................................ 3-61

4.2  Sharpness settings (Sharpness) .................................................................... 3-68

4.3  AI Setup (AI Trim) .......................................................................................... 3-74

4.4  Settings for mode conversion (HD, SD, MAX, MIN, ICR, Mixing ratio) .......... 3-76

4.5  Enlarging/reducing, scrolling and color picking.............................................. 3-83

5.  Precautions when changing the setup parameters ............................................... 3-84

Chapter 4  Utilizing convenient functions ......................................................................... 4-1

1.  Customizing ............................................................................................................ 4-1

1.1  Keyword customization .................................................................................... 4-1

1.2  Profile customization........................................................................................ 4-2



vi

1.3  Editing image handling parameter preferences ............................................... 4-4

1.4  Negative AI film parameter edit ........................................................................ 4-5

1.5  Sharpness customization................................................................................. 4-9

1.6  Learning function ........................................................................................... 4-10

2.  Recall setup and apply recipe ............................................................................... 4-13

2.1  About the recipe file ....................................................................................... 4-13

2.2  Recalling the previous setup with recipe file .................................................. 4-14

2.3  Applying the previous recipe .......................................................................... 4-14

3.  Modifying a selected color .................................................................................... 4-16

3.1  Tone change .................................................................................................. 4-17

3.2  Color change ................................................................................................. 4-17

3.3  Setting the effective area ............................................................................... 4-18

3.4  Enlarging/reducing, scrolling and color picking.............................................. 4-19

4.  Reuse of the RGB images .................................................................................... 4-20

4.1  Saving in the local storage............................................................................. 4-20

4.2  Search ........................................................................................................... 4-22

4.3  Edit and calculation........................................................................................ 4-24

4.4  Deletion and re-registration ........................................................................... 4-25

4.5  Local storage maintenance............................................................................ 4-26

5.  Hot folder .............................................................................................................. 4-29

6.  Opening all image files in a folder at once ............................................................ 4-31

7.  Example usage of hot folder and folder open function ......................................... 4-35

8.  Scanning using the optional compound tray ......................................................... 4-37

8.1  About the compound tray set ......................................................................... 4-37

8.2  Scanning using the compound tray ............................................................... 4-38

Chapter 5  Using the Make Profile Tool .............................................................................. 5-1

1.  The Output profile making tool ................................................................................ 5-1

Chapter 6  Line Art ............................................................................................................ ... 6-1

1.  Prescanning ............................................................................................................ 6-1

2.  Line art controls ...................................................................................................... 6-2

3.  Server registration .................................................................................................. 6-6



Chapter 1  Introduction to ColorGenius

1 - 1

Chapter 1  Introduction to ColorGenius

1.  What is ColorGenius?
ColorGenius is an image processing software package that allows you to

convert RBG images imported with a scanner into CYMK/grayscale

images after adjusting the color tone and color density of images for

optimum-quality output.

You can set up ColorGenius to output images as you want them to be.

This is achieved simply by selecting the original input image type, the

finished image style, and the output image mode. The Manual fine adjust

command enables more accurate adjustments to be made, giving images a

refined touch.

By using ColorGenius with our scanner, the FT-S5500, efficient scanning

operations are achieved in a client/server environment.

Image files in the TIFF, EPSF and JPEG formats, captured (and saved)

with hardware other than connected scanners, can also be imported

directly to ColorGenius.

The features of ColorGenius are described in the following.

Easy Setup
You can easily set ColorGenius by selecting the desired item for the

following three options: the original image type to be input, the finished

image style, and the output image mode.

The first option can be set by selecting either [General], [Portrait],

[Machines], or [Scenery].  In [Portrait], more detailed settings can be made,

i.e., either [Flesh intensive (Light)] or [Flesh intensive (Dark)] can be chosen.

For the second option, you can choose from ten alternatives, such as

[Bright], [Soft], [High Contrast], etc.

Manual fine adjustment
With the Easy Setup, setup commands can be established simply by

selecting keywords for the mode, type and finish of the individual images.

The Manual fine adjustment, in contrast, allows you to create more

precise setup commands (to determine suitable values and strengths for

each parameter, i.e., color correction or sharpness) to be used for

individual images.
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AI Setup
ColorGenius contains a feature called AI Setup, with which suitable

highlight and shadow points in input images are automatically analyzed

and set.  In addition, common color components in the highlight and

shadow areas can be analyzed and the color balance of entire images can

be adjusted by removing the cast color.

In the Manual fine adjust mode, the settings for AI Setup can be

corrected.  Note that it is possible to perform the AI Setup without

spoiling the impressions of the high/low key originals, and eliminating the

large portions of cast in faded color originals can be achived.

Color Mode Conversion
RGB images input from a scanner are converted to CMYK/grayscale

images.  With CMYK images, it is possible to set the halftone dot sizes

(%) at highlight/shadow points and the entry point density for K

separation (K-shift).  You can also set the ICR function and the UCR/

UCA function.  With grayscale images, it is possible to set mixing ratio to

be applied when converting the R, G, and B tonal values for each pixel to

grayscale values.

Line Art Input
Line art (one-bit images), such as letters and logos, can be input to

ColorGenius only when the FT-S5500 is connected.   It is possible to

input line art at any selectable resolution, and the threshold levels that

distinguish between white and black portions of an image can be set

individually according to the density of the original.

Calibration
If you use different types of scanners, the color of the input images will

differ even when scanning the same original.

In the same manner, if you use different types of monitors, the color of

the images displayed on the monitor may differ even when using the same

image file.

ColorGenius uses the ColorSync function of Mac OS, and this makes it

possible to ensure color consistency between the original and the image

displayed on the monitor. With this function it is possible to simulate the



Chapter 1  Introduction to ColorGenius

1 - 3

final image color on the monitor, output the proof data from the color

printer, and receive the RGB image from the scanner (excluding the FT-

S5500) or the digital camera, with image color maintained.

Adjustment of parameters within the image processing command
Commands for adjusting the color/sharpness in ColorGenius will allow

you to generate miscellaneous effects in images by setting the parameters

(appropriate content/amount) precisely.

By selecting [Setup parameter editing] , image processing settings, which

match with the operating environment and the desired finishes, can be

made by adjusting the parameter settings to determine the appropriate

content/amount.

2.  ColorGenius Operating Environment
ColorGenius can be implemented in one of the following operating

environments.

2.1  Client/Server Environment
A Client/Server Environment is an operating environment in which two

connected computers are used; one computer is designated as the server

and the other as the client.  In this client/server environment, ColorGenius

implements scanning/setup operations for the image using the FT-S5500

scanner connected to the server through a SCSI interface.

After an original is pre-scanned with the FT-S5500, the client will first

receive the image input via the server, and will then start the setup

procedure on that (low-resolution) image.  After the setup procedure for

the image with low resolution is completed, a file containing the setup

command and trimmed area data is transmitted to the server.  Upon

receiving this file, the server receives command from the client to start the

actual scanning of the original with the FT-S5500, to execute the setup

command for that (full-resolution) input image, and to save the image

data in a specific location of the server.
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Setup sequence

*Setup

In ColorGenius, the setup involves a series of operations, beginning with

the setting of the crop/rotation/color tone/color density/sharpness

parameters and ending with the output of information to a file after

conversion of an RGB input image to a CMYK/grayscale image.

Client
The client is a platform where the setup data is created. Images displayed

on the client’s monitor are low-resolution images (prescanned and

enlarged).  Therefore, the client allows simulations to take place before

the actual scanning of (full-resolution) images on the server.

Server
The server is a platform to which images are input from a scanner at their

full resolution.  The setup command saved in the setup file for an image is

executed on that image by the server.  Each image whose setup is

completed is saved in a specific location of the server.

Client Server FT-S5500

SCSI

Ethernet (TCP/IP)

Image with low resolution

Image after conversion

Saving 

 

Prescanning

Creating the setup 
data

Designating the 
actual scanning

Actual scanning

Executing the setup 
command

Full resolution image
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Scanner (FT-S5500)
The FT-S5500 is the only scanner that can be connected with

ColorGenius in a client/server environment.

As mentioned above, in a client/server environment, heavily-loaded

operations, e.g., actual image input and setup command execution, are

implemented on the server. Since the client is released soon after

transmitting the setup file to the server, the setup operations for the next

original can be commenced on the client while scanning is being

performed on the server.

The execution of consecutive scanning operations is also possible in a

client/server environment by implementing the execution of continuous

setup operations for multiple pre-scanned originals on the client and

transmitting the created setup files in a batch to the server.  This method

is called “batch scanning”.  In batch scanning, the FT-S5500 implements

the scanning not in the order the server receives files but in the order that

allows the most effective scanning to take place, that is, through an

analysis of the location/type/setup data contents of each original.
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2.2  Multi-client/server environment
In the client/server environment described above, one of two computers is

designated as the server and the other as the client.  On the other hand, in

a multi-client/server environment, several clients can be connected to a

single server.  Operational procedures in this environment are almost the

same as in the client/server environment.

2.3  A client/server environment within a single computer
In a single computer, a “dummy” client/server environment can be

established by running both client and server applications.  The sequence

concerning the setup operations on a single computer is basically the

same as that for two computers.  Background scanning and batch

scanning are also available, Although background scanning and batch

scanning are also available, slowdown/standby problems may occur on

the client side if the computer’s capacity is insufficient. This is because a

single computer performs both client and server operations.

Router
LAN

Client

Client

Server

Router

Client
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2.4  Server assistant
Server assistant is the software that supports the handling of image files

that were scanned but not processed. The following functions are

available after the server assistant is installed in a Macintosh already

equipped with a server application.

• Storing and reusing RGB images

This function enables you to store the RGB images that were scanned

but not processed in local storages (simple database) and to reuse the

stored images. After storing these scanned images, the images can be

reused without re-scanning their originals. When storing the images,

keywords can be attached to them. The stored images can be easily

searched using the keyword that is attached to each image.

FT-S5500

RGB
Setup

processing CMYK

Stored

Local 
storage

ColorGenius

RGB CMYK

Search

ColorGenius

Setup
processing

Recipe file

Recipe file Correction
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• Automatic processing using a hot folder

This function enables you to perform image processing automatically

by simply moving RGB images to a specific folder (hot folder) that has

been assigned a recipe file that contains a processing method. This

function is useful when images photographed with a digital camera or

some other such device are batch processed.

• Opening all image files in a folder at once (folder open function)

This function enables you to open all RGB images in a specified folder

at the same time; it is useful when manually processing images

photographed with a digital camera or some other such device.

Sorting using 
browsing software

Image files to be 
automatically 
processed

Unnecessary 
image files

Image files requiring 
fine-adjustment

Hot folder

Trash

Opening all files at once by 
folder open function and then 
processing one at a time

Automatic
processing in
ColorGenius

Digital camera

2.5  Standalone Environment
In the standalone environment, only the client is used. You cannot

connect a scanner or the server assistant to a computer in this

environment; only image files can be opened.
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3.  Image Types and Resolutions
Knowledge on color characteristics/properties is essential when dealing

with digital images.  It is also important to have general knowledge on

pixels and resolutions for digital images.

3.1 Color Models
Several color models have been investigated to indicate colors

numerically.  The RGB/CMYK/HSL/L*a*b* models are typical

examples.  An understanding of the theories behind the four color models

is important before adjusting colors on images and/or converting input

RGB images to other mode images using ColorGenius.

RGB Model
Most of the colors existing in the natural world can be reproduced by

mixing and projecting the three red(R)/green(G)/blue(B) lights in various

strengths.  When each of these three colors applies an equal value of

brightness, the white color is produced.  When each of these applies a

value of brightness of 0 (no brightness), the black color is produced.

In this sense, in the RGB model, the method of producing color is called

an “additive process” since colors are created by combining (mixing)

different strengths of red, green, and blue lights.  The RGB model is

widely adapted to computer monitors and scanners.

R

G

B
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CMYK Model
When a specific color component (e.g., red) is subtracted from white

light, the color changes to another color (e.g., cyan).  Other examples are

as follows:  subtracting green results in magenta and subtracting blue

results in yellow.  Subtracting all of the color components from white

light results in black.  In this sense, this method of creating color is called

a “subtractive” process.

By piling transparent color layers over white paper, a new color is created

since a specific color component (in the incident light) is absorbed by

those piled layers.

The CMYK model is widely used to specify the inks for printed material;

color images are analyzed into four color separations.  Four color inks

(cyan, magenta, yellow, and black) are used for printing. Theoretically,

the black color can be created by mixing cyan, magenta, and yellow;

however, pure black cannot be created because of the density

discrepancies between the three ink colors or mixture with foreign matter.

Therefore, we also use black ink for printing.

Magenta

YellowCyan

RedBlue

Green

+
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HSL Model
The HSL color model describes colors with the three elements of “hue”,

“saturation”, and “luminance” based on the perceptions of humans.

Hues are arranged around a standard color wheel, where each degree on the

wheel (from 0 to 360 degrees) identifies a unique color, such as red, green,

etc.

Saturation refers to the strength of a color from 0% (gray) to 100% (pure).

Luminance refers to the brightness of a color from 0% (black) to 100%

(white).

L*a*b* Model
The L*a*b* color model was standarized as an international color

specification by the Commission Internationale de l’eclairage (CIE) in

1976.  This model allows you to reproduce stable colors at any time

independent of any monitor, scanner and/or I/O device.

Luminance

Higher

Lower

Saturation
HigherLower

Hue

0˚

Color wheel

180˚

L=100
White

L=0
Black

+a-a

-b

+b
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In the L*a*b* model, the L* represents the luminance of an image

(L*=100 represents white and L*=0 represents black) and both a* and b*

represent all of the information on the hues and saturations.  A positive

direction (+) for the a* value represents magenta while a negative

direction (-) represents green.  A positive direction (+) for the b* value

represents yellow, while a negative direction (-) represents blue.  The

larger the tonal value (absolute value), the higher the saturation and the

smaller the tonal value (absolute value), the lower the saturation.

3.2 Pixels and Resolution

Pixels
Images processed by a computer are made up of aggregated dots, each of

which is called a pixel. The more image information a pixel has, the

higher the potentiality for image reproduction.  For example, if an image

is based on the RGB model, the number of colors capable of being

rendered depends on how many steps of each color the hardware can

generate.

With the FT-S5500, an image can be input in either 8 bits/pixel (24-bit

color) or 16 bits/pixel (48-bit color).  In the former case, 256 (2 to the 8th

power) steps can be expressed, and this means that 16.7 million (256 to

the 3rd power) colors or more can be expressed with the FT-S5500. By

applying 48-bit color, grandscale colors (2 to the 48th power) can be

expressed.

Image Resolution
The image resolution indicates the finess of pixels, by which images are

created, and is expressed in pixels per inch (ppi) or dots per inch (dpi).

The higher the image resolution, the more precisely the colors and shapes

of an input image can be reproduced.

Image Resolution and Image Size
Since the number of pixels in an image input from a scanner or retrieved

from a file is predetermined, the image resolution can be changed by

varying the image size.  More specifically, enlarging the image size

results in a decrease of the resolution since the size of each pixel is

enlarged.  On the other hand, reducing the image size results in an
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increase of the resolution since the size of each pixel is reduced.

If the resolution of an image is decreased from 300dpi to 150dpi, the

image size becomes twice (both horizontally and vertically) the size of the

previous one.  On the other hand, if the resolution of an image is

increased from 150dpi to 300dpi, the image size becomes half the size of

the previous one.

If the image resolution of an image is increased without changing the

image size, new pixels are generated within the image.  As a result, the

image quality is decreased and the image may become unclear.  On the

other hand, if the image resolution of an image is decreased without

changing the image size, some pixels are deleted.  As a result, although

this process is useful for decreasing the digitized dimensions of the image

file, careful consideration of the image quality is necessary.

Relation between the image resolution and digitized dimensions of a

file
The digitized dimensions of an image file is proportional to the resolution

of the image when the image size is fixed. As an example, an image with

300 dpi resolution has a digitized file size four times as large as the same

size of image with 150 dpi resolution.

3.3 Types of originals that can be input
Originals capable of being input to ColorGenius are categorized into four

types:  positive films (transparent originals), negative films (transparent

originals), reflective originals (photographs, prints, etc.) and printed

material (reflective screened originals).  In addition,  line art images (1-bit

images) of either the reflective type or transparent type can also be input

provided the FT-S5500 scanner is utilized.

Transparent/Reflective Originals
Color photography originals are divided into two types:  transparent

originals (films, etc.) and reflective originals (prints from a photographic

film, etc.).  In the former case, an image is captured by reading the

applied light penetrating through the original.  In the latter case, an image

is generated by reading the applied catoptric light from the original.  The

FT-S5500 scanner can perform scanning for both types of originals.
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Positive Conversion of Negative Originals
ColorGenius has a feature to convert negative images into positive ones.

This positive conversion is executed by the conversion parameter file

called “Nega AI Parameter File”.  The parameters have been preset

corresponding to specific commercial films so as to produce the optimum

conversion results.  By using the “Negative AI film parameter editing”

function, these default parameters can be changed and new parameter

settings for conversion can be created.

Defocusing the dots on printed material
Reflective originals can be divided into two types:  originals represented

in a continuous tone, such as photographs, and originals represented by

dots such as printed material.

With originals represented by dots, if the scanning is executed at full

resolution, the dots may remain in the input image as they are.  In such

cases, you may decide to defocus the dots by scanning and inputting the

image using the defocus filter and acquire a smoothed image. Selecting

“Printed Material” from the “Original” pull-down menu will allow you to

scan and input images using the defocus filter.

Line Art
With the FT-S5500, not only color/grayscale images with tones but also

line art (characters, logos, etc.) can be scanned and input.  Like with color

photography originals, both transparent originals (films) and reflective

originals (mechanicals) can be scanned.

Reflection mirror Lens

Photosensor Photosensor

Scanning a transparent original Scanning a reflection original

Original Original

Source of the applied 
light penetrating 
through the original

Source of the applied 
catoptric light from the 
original
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4.  Installation
The procedure for installing ColorGenius is described in the following.

Installation should be performed separately on the server and client in a

client/server environment.

4.1 Cautions to be observed before installation
With the use of the Installer contained in the ColorGenius CD-ROM, you

can install the following.

• “ColorGenius” as the client application.

• “Server” as the server application.

• “Assistant” as the server assistant application.

• “OtherTools : MakeProfile (for FT-S5500) : MakeProfile” as Profile

Customization tool tools.

• Folders which contain files necessary for ColorGenius.

• “FT-S5500 Plug-in”, an import plug-in module with which the

images scanned with the FT-S5500 can be used in PhotoShop.

(The FT-S5500 Plug-in is only installed when Mac OS 9.X is used.)

• “FT-S5500 Maintenance” folder, in which maintenance tools for the

FT-S5500 are included.

Be sure to install all of the files on the server by selecting “easy

installation”.  Server (a server application or server assistant) is not

necessary on client machines, but it will not interfere with client

operations if all files in Server are installed on client machines by

selecting “easy installation”.

Recommended Macintosh Environment
For best results when using ColorGenius, a Power Macintosh with the

following specifications is necessary.

Computer: Power Mac G3 or higher (Recommended : Power

Mac G4 or higher)

System software: Mac OS 9.1 or higher, Mac OS X 10.1 or higher

Hard disk: 5 GB, or five times the input image size required for

storing the scanned image, is recommended.

(Minimum 500 MB)
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Memory: 512 MB or more is highly recommended when using

only one machine in a client/server environment.

(Minimum requirement is 286 MB) *1 *2

For a dedicated server machine, 384 MB or more is

recommended.  (Minimum requirement is 222 MB)*1*2

For a dedicated client machine, 384 MB or more is

recommended.  (Minimum requirement is 160 MB) *1

If the machine only incorporates the Plug-in

application, 224 MB or more is recommended.

(minimum requirement is 196 MB)

*1 .... Using deMoire (option) requires another 32MB

in the memory.

*2 .... Using DotFinder (option) requires another

32MB in the memory.

CD-ROM drive:  Built-in, or peripheral.

Display: 21 inch full-color display

Display Card: A display card (supporting monitors 17 inches or

larger) with full-color (at least 32768 colors) support.

Note • ColorGenius incorporates a network software license

protection function, so it not possible for multiple Macintosh

computers on the network to simultaneously use a single

copy of ColorGenius which has been registered with only one

serial number.  Please purchase the desired number of

ColorGenius software copies if you need to run more than

one instance at the same time.

• Because the configuration of the recommended system varies

in accordance with the model change of the Macintosh or

upgrade of the OS, for the detailed information contact the

personnel in advance.

4.2 Installation Procedure
Be sure to close all applications, if any are open, before commencing the

installation procedure.

Select an OS (either Mac OS 9.X or Mac OS X) on which the

ColorGenius is to be used, and start up the computer on the selected system.
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1) Start up the computer and confirm the display of the desktop

window.

2) Insert the installer CD into the CD-ROM drive.

3) Double click the “ColorGenius” icon.

4) Double click the “ColorGenius Installer” icon.

Note In order to install the ColorGenius in Mac OS X, you must

login at an administrator level. When installing the software,

log into the Macintosh using the administrator’s privileged

user name. (The user name specified during the first start up

of Mac OS X becomes the administrator name).

5) Click “Continue”.

The “ColorGenius Installer” window is displayed .

Select the destination
where the files of
ColorGenius are to be
installed.

Select how to install
ColorGenius.
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6) Click “Install” after selecting how to install ColorGenius and its

destination, to begin the installation process.

The dialog box, in which you can specify where to install the “FT-

S5500 Plug-in” (module for inputting scanned images compatible

with PhotoShop), appears.

7) Designate the “Import/Export” folder in the PhotoShop “Plug-ins”

folder, and then click on “Select”.

A dialog box that indicates the download status is displayed on the

screen.

Note The dialog box shown below appears only on Mac OS 9.X.

8) After the installation process is completed, a confirmation dialog box

is displayed on the screen.  Click “Quit” to quit the installer.

9) Double click the “ColorGeniusEX” (client application) icon.

Enter the “Name”, “Organization” and “Serial No.” in the opened

registration dialog.

The serial number is noted on the CD-ROM case.
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10) In the same manner, double click the “Assistant” (Server assistant)

and “Server” (Server application) icons.

Enter the “Name” , “Organization” and “Serial No.” in the opened

registration dialog.

Initializing the ColorGenius Preference file
ColorGenius has memorized the previously used environment in its

ColorGenius Preference file in the Preferences folder (System folder).  At

any time when you re-install the application for some reason or delete the

previously used profile, it is necessary to initialize this ColorGenius

Preference file.

To initialize the ColorGenius Preference file:

Launch ColorGenius, the client application, while simultaneously holding

down the Command and Option keys.  The message of “Preference file is

built again” appears. Clicking on “OK” will initialize the data in the

ColorGenius Preference file, and then ColorGenius is launched.

Note Be sure not to delete the profiles installed when installing

ColorGenius, because a profile will be loaded when launching

the application, after the ColorGenius Preference file is

initialized.
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Chapter 2 Operation environmental settings

ColorGenius can be used in the following environments.

• Client/server environment

• Client/server environment on one computer (hereafter referred to as the

“Foreground/background environment”)

• Multi-client/server environment

• Server assistant

Note One of the following environments is required when using the

server assistant.

• Client/server environment

• Foreground/background environment

• Multi-client/server environment

• Standalone environment

The operating environment setting depends on the configuration of the

machines used at your site.  Choose the environment best suited to your

equipment and needs.

To use ColorGenius in the client/server environment or the multi-client/

server environment, it is necessary to connect the client and server

computers and perform the appropriate settings.

The first half of Chapter 2 describes the network setup and the default

setup regarding FT-S5500 operation.  The latter half explains the

ColorGenius default setup and calibration method.

• If your ColorGenius will be used in the client/server environment,

please refer to “1. Client/server environment setup”.

• If your ColorGenius will be used in the Foreground/background

environment, please refer to “2. Foreground/background environment”.

• If your ColorGenius will be used in the multi-client/server

environment, please refer to “3. Multi-client/server environment

setup”.

• If your ColorGenius will be used in the server assistant environment,

please refer to “4. Server assistant”.

• If ColorGenius is used in the standalone environment. Refer to only “6.

ColorGenius default setup” and “7. Color calibration setup”.
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Memory requirements for the machine and memory allocation for

applications

Note For Mac OS X, an application memory cannot be allocated.

Therefore, the following operations are not necessary for Mac

OS X users.

In ColorGenius, the default RAM size allocated for “Preferred Size” of

ColorGenius Client (client application) and ColorGenius Server (server

application) is the same amount as “Suggested Size”.

Since the ColorGenius Server performs calculations when images are

scanned by the FT-S5500, when its setup parameters are set, and while

saving image data temporarily into the ColorGenius Server’s application

memory, sufficient RAM for handling this data is required.

If insufficient physical memory (RAM) is allocated to the ColorGenius

Server application, this will cause a memory shortage when scanning

images or setting up image parameters.  If the ColorGenius Server runs

short of memory, the deficit will be secured by creating a file on the

scratch disk and then saving the image data temporarily into that file.

However, this situation should be avoided if at all possible, because

creating a file on a scratch disk causes the ColorGenius Server to

frequently access the disk, reducing the speed of processing.  This

situation not only slows image parameter setup (since disk reads and

writes are far slower than those to RAM) but will also periodically pause

scanning from FT-S5500, due to the scanner’s “start & stop function”,

resulting in extremely slow scanning operations.

If the ColorGenius Client’s RAM allocation is low, the prescanned

images display speed may be reduced.

Moreover, in general, Macintosh machines use approximately 32 MB of

memory for the operating system (OS). Therefore, the amount of memory

to be installed in each Macintosh should be the sum of the memory to be

allocated to the applications to be run, and the memory needed for the OS.

Taking the above into account, install memory in the following minimum

amounts and application allocations.
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When both Server and Client are run on one Macintosh (in a

client/server environment)

• Client application

 Recommended 64 MB.

• Server application

 Recommended 96 MB.

• Server assistant

Recommended 30 MB.

286 MB or more memory is required in total, including a maximum

of 96 MB (approx.) for the OS.

When the Server and the ColorGenius Client are run on separate

Macintoshes (in a server/client environment)

• Client application

Recommended 64 MB.

96 MB or more memory is required in total, including the 32 MB for

the OS.

• Server application

Recommended 96 MB.

• Server assistant

Recommended 30 MB.

222 MB or more memory is required in total, including a maximum

of 96 MB (approx.) for the OS.

Note Open the control panel/memory of the Mac OS, and turn OFF

the Virtual memory.
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1. Client/server environment setup
To use ColorGenius in the client/server environment where two

computers are used, it is necessary to connect these computers to the

network with a cable.  In addition, the following setup information must

be entered in order to link the server application on the server computer

and the client application on the client computer.

1.1 Server setup
In order to connect the client and server computers, the following setup

information must be entered on the server computer.

• Network ID

• TCP/IP

• Scratch disk

• Disk for saving scanned images

Network ID setup (For Mac OS 9.1 users)
• Select “File Sharing” in the control panel.

• Fill in the columns for “Owner Name” and “Computer Name”.  The

“Computer Name” entered here will appear when connecting to the

server computer.

• Select “Quit” from the File menu.
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Setting up TCP/IP
TCP/IP background

ColorGenius transfers setup data or image data between the client and

server computers using TCP/IP on an Ethernet network.

Note When both client and server applications run on a single

computer, TCP/IP setup is not necessary.

Before utilizing TCP/IP, you must obtain an IP address for each

Macintosh that will run the Server Application, Client Application.

Most Macintosh users are familiar with AppleTalk, a network protocol

that ships with every Macintosh and is used whenever you connect to an

AppleShare file server or print to a LaserWriter.  TCP/IP is a protocol that

is commonly used on cross platform networks or on the Internet.  Like

AppleTalk, it allows applications to exchange data over a network.

Every computer on a TCP/IP network must have a unique address, known

as an IP address.  An IP address consists of four numbers (each in four

bits) separated by periods, for example, 192.168.6.187.

Subnets have a function on a TCP/IP network similar to that of zones on

an AppleTalk network.  A group of computers connected to the same

TCP/IP network is known as a subnet.  The subnet mask indicates how

many digits of the IP address will change from computer to computer.

Organizations with a subnet mask of 255.255.255.0 will only change the

last number in each IP address, while ones with a subnet mask of

255.255.0.0. will change the last two numbers.

Routers play a similar role on TCP/IP and AppleTalk networks: they

allow your computer to communicate with computers on other networks.

The router address (also known as the gateway address) is the address that

your computer will use when it needs to communicate with a computer

not on the local subnet.

Obtaining an IP addresses
How you obtain the IP addresses for computers on your network depends
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on whether your organization currently uses TCP/IP and whether you

have or plan to have a direct connection to the Internet.

• If your business already uses TCP/IP on its network:

Obtain the IP addresses and TCP/IP configuration instructions from your

network administrator.

• If your business is not using TCP/IP now, but has or plans to

have an Internet connection:

Ask your Internet service provider for a range of IP addresses and the

appropriate TCP/IP configuration information.

• If your business does not use TCP/IP now, and is not

connected to the Internet:

A range of IP addresses has been set aside for organizations not connected

to the Internet.  This range of addresses begins with 192.168 (class C).

Organizations can then assign the other two numbers to each of their

computers as needed.  A valid address, for example, is 192.168.1.10.  If

you fall into this category, use the following to configure TCP/IP on your

network:

IP Address (Server application) for a Macintosh that will run the

Server application:

192.168.1.1

IP Address (Clients application) for a Macintosh that will run the

Client application:

192.168.1.2, 192.168.1.3, etc.

(For each additional machine to be configured, increase the last

number of the IP address by one.)

Subnet mask:

255.255.255.0
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Note Before attempting the configuration below, please consult

your network administrator.  The following instructions are

only for networks not currently using TCP/IP, which will not be

connected to other networks, such as the Internet, in the

future.  In this procedure, the IP address of the Server

application Macintosh is set to 192.168.1.1 and its subnet

mask is set to 255.255.255.0 (class C).  The IP address of the

Client application Macintosh is set to 192.168.1.2 with its

subnet mask set to 255.255.255.0 (class C).  If your network

administrator sets a different TCP/IP configuration, follow that

designation.

For Mac OS 9.1 users

1) Open the TCP/IP Control Panel.  If TCP/IP is not used, the following

dialog box appears.  Click "Yes".

2) From the "Edit" menu, select "User Mode" and set the user mode to

"Advanced".  Click "OK" button.

Ethernet Network

Server
application

Example)
 IP Address 192.168.  1.1 192.168.  1. 2

 Subnet Mask 255.255.255.0 255.255.255. 0

Client
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3) Choose your current network connection, for example, "Ethernet",

from the "Connect via" pop-up menu.

4) Select "Manually" from the "Configure" pop-up menu.

5) Enter your IP address in the "IP Address" field in one-byte

characters.

6) Enter your subnet mask (255.255.255.0) in the "Subnet mask" field

in one-byte characters.

7) Enter your router address in the "Router address" field.  If you have

no TCP/IP router on your network, leave this field blank.
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8) Click the "Option" button.  Make sure that "Load only when needed"

is unchecked.  Click "OK" button.

9) Close the TCP/IP Control Panel.  Click "Save" when the

confirmation dialog appears.  You do not need to restart your

Macintosh.

For Mac OS X users:

1) Click the “System Preference” icon on the dock.

2) Click the “Network” icon.
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3) Set up TCP/IP. The setup procedure is same as the TCP/IP setup for

Mac OS 9.1.

4) Click the “Save” button.

Scratch disk setup
In the server application, prescanned or processed image data are

temporarily saved to a disk, called a scratch disk.

Set a server volume for the scratch disk.

While it is possible to use a mounted volume as the scratch disk (a

volume of a computer on the network), processing time will be

significantly increased.  We therefore recommend that you use a server

volume as the scratch disk.

Select “Preference” from the Preferences menu in the server application

to setup a scratch disk.

Designating a RAM disk as a scratch disk
With the ColorGeniusServer, prescanned image data are temporarily

saved to disk.  Setting a RAM disk as the scratch disk (for prescan)

enables you to increase the write speed for the prescanned image,

reducing scanner pausing, thus improving the speed for transmitting the

prescanned image data to the client machine and displaying the image on
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its monitor.  If you have installed enough memory in your Macintosh, and

140 MB or more RAM is left unallocated (excluding 32 MB for the OS),

then set this 140 MB or more up as a RAM disk.

Note When you set up a RAM disk as a scratch disk, however, it is

necessary to set the size larger than the prescanned image

data maximum.  With the 288 dpi resolution setting, the

prescanned image data size can approach 140 MB

(approximate maximum).  You should therefore set the RAM

disk for 140 MB or more memory for use as the scratch disk.

If you allocate a portion of the RAM disk to scratch disk and

the allocated memory is smaller than the prescanned image

data, this will cause a “disk full” error.

Designation of a disk for saving scanned images
Scanned image files will be saved to the designated server volume or

volume mounted on the server (a volume accessible from the server

computer).

If you wish to save scanned image files to a computer volume on the

network, mount the volume beforehand.
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External 
computer

FT-S5500

Client Server

Network

Disk for saving
scanned images

Scratch disk 
(for prescan)

Mounting

Example 1) When you want to save scanned image files to the client

computer:

Example 2) When you want to save scanned image files to an external

computer on the network (GTP):

Client Server

Network

FT-S5500

Disk for saving
scanned images

Scratch disk 
(for prescan)

Mounting
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Server application setup
1) Start up the server application and select “Preference” from the

Preferences menu.

2) Set the port number.

Normally, it is not necessary to change the factory assigned default

port number. If, however, the assigned port number has already been

used for another network application, change the port number.

3) Click the “Apply” button..
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“Connect” button

1.2 Client setup
The following setup information must be entered on the client computer

in the same manner as in “1.1 Server setup”.

• Network ID

• TCP/IP

Setup when connecting to the server computer
The following dialog box will appear as the client application starts up or

when the “Connect” button on the tool palette is clicked.

If the server application and the client application exist either in the same

Macintosh or the LAN sub-network, this information appears in the upper

box.

If the server computer’s router address differs from the one for the client

computer, place a check in the “Specify IP address and port number”

check box and then enter the server’s IP address and port number.

Note Enter the same port number as the one set in “Preference” in

the Preferences menu.
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1.3 Linking the client and server computers
With the procedure explained above, you have now completed the setup

for the server and client machines to use the network.  Next, this section

describes how to launch the ColorGenius server and client applications on

the respective computers and link them together.

1) Launch the “Server” application in ColorGenius from the server

machine.

When the application is properly launched, Log Window appears on

the server monitor as shown below.

2) Launch the “ColorGeniusEX ” client application in ColorGenius

from the client machine.

After the start-up screen, the initial display of ColorGenius appears.

3) Click the “Connect” button on the tool palette.

The dialog box for selection of the server machine and the server

application is displayed.



ColorGenius EX USERS MANUAL

2 - 16

If the server computer’s router address differs from the one for the

client computer, place a check in the “Specify IP address and port

number” check box and then enter the server’s IP address and port

number.

Enter the same port number as the one set in “Preference” in the

Preferences menu.

4) Click the “Server” (server application).

If the “ColorGenius Server” (server application) is not listed, check if

the correct IP address has been set and if the server application has

been launched on the server computer.

5) Click “OK”.

The server application in ColorGenius has now been linked with the client

application.

“Connect” button
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2. Foreground/background environment
The following setup information must be entered.

• Network ID

• Scratch disk

• Disk for saving scanned images

Perform the setup in the same manner as for “1. Client/server

environment setup”.

The TCP/IP setup is unnecessary.

After all the above setup information has been entered, link the client and

server applications, referring to “1.3 Linking the client and server

computers”.  Note that the “Specify IP address and port number” check

box should be unchecked, when you see the dialog box that appears when

connecting to the server.

“Connect” button
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3. Multi-client/server environment setup
With ColorGenius, multiple clients can be connected to one server.

The multi-client/server environment is effective in two configurations as

described in the figures below.

Fig. A

Fig. B

Note • A maximum of three clients can be connected to a server.

• We recommend you use the configuration shown in the Fig.B,

since the processing speed is faster.

Network

Server
application

Client
application

Client
application

Client BServer & Client A

Client
application

Network

Server
application

Client
application

Client BClient A Server
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3.1 Server setup
The following setup information must be entered.

• Network ID

• TCP/IP

• Scratch disk

• Disk for saving scanned images

Perform the setup in the same manner as for “1.1 Server  setup”.

Server application setup
Set the server application, following the explanation in “Server

application setup” of “1.1 Server setup”.

1) Start up the server application and select “Preference” from the

Preferences menu.

2) Place a check in the “Use in multi-client environment” check box.

3) Set the port number.

We strongly recommend that you not change the factory assigned

default port number, if the server-client connection is operating

properly.

If you have been using any other network application (e.g. a WWW

browser, e-mail, etc.), be sure not to specify an already used port

number when setting up the server application, or quit the other

network application(s) before entering this data.

4) Click the “Apply” button.
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3.2 Client setup
The following setup information must be entered.

_ Network ID

_ TCP/IP

Perform the setup in the same manner as for “1.2 Client setup”.

3.3 Linking the client and server computers
Link the client and server computers referring to “1.3 Linking the client

and server computers”.
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4. Server assistant
One of the following environments is required when using the server

assistant. After setting up each environment, set up the corresponding

environment for the server assistant.

• Client/server environment

• Foreground/background environment

• Multi-client/server environment

Note Be sure to install the server assistant in a Macintosh in which

the server application is already installed.

Network

Server
assistant

Client
application

Server
application

Server
assistant

Client 
application

Server
application

Server
assistant

Client
application

Network

Server
application

Client
application
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4.1 Server assistant setup
1) Launch the server assistant.

2) Select “Preferences” from the File menu.

3) Set “Hot folder for register in the storage”.

Use the default setting. From the client application, designate the

folder that is to be the local storage where image files should be

registered. When you wish to change the folder, click the “Folder”

button and designate a new destination folder.

4) Set “Shared folder with ColorGeniusServer”.

Use the default setting. Designate the folder where image files should

be sent from the server assistant in the server application. When you

wish to change the folder, click the “Folder” button and designate the

new destination folder.
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5) Set the port number. Normally, it is not necessary to change the

factory assigned default port number. If you have been using any

other network application for the port number (e.g., a WWW

browser, server application), change the port number.

Setting up a local storage:

1) Set the local storage.

Click the “Create…” button.

2) Click the “Storage…” button, and designate the location (folder) of

the local storage and local storage name.

Note Make sure not to create a local storage in the folder or sub-

folders of the ColorGenius EX, as doing so may cause an

operation error.

Button Function

Create Creates a new local storage.

Modify Performs maintenance for the present local storage

(e.g., keyword modification, image deletion).

Delete Deletes the present local storage.

Open Opens the separately created present local

storage so that it can be operated.
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3) Click the “Save” button.

4) Set the keyword.

Set the image-classifying keywords in the local storage.

When creating a new local storage, delete or modify the preset

default keywords, if necessary.

5) Click the “Create…” button.

6) Enter a keyword and click the “Apply” button.

7) Click the “Quit” button.

Setting up a hot folder:

1) Set the hot folder.

Click the “Create…” button.

Button Function

Create Creates a new keyword.

Delete Deletes the present keyword.

Modify Modifies the present keyword.
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2) Designate the location (folder) of the hot folder.

Click the “Folder” button and designate the folder.

Note Make sure not to create a hot folder in the folder or sub-

holders of the ColorGenius EX, as doing so may cause an

operation error.

3) Click the “Choose” button.

Button Function

Create Creates a new hot folder.

Modify Modifies the present output destination folder and

the present hot folder type.

Delete Deletes the present hot folder.

Open Modifies the present location (folder) of the hot

folder.
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4) Designate the folder where image files, which have been

automatically processed and output from the hot folder, should be

stored.

Click the “Folder” button and designate the folder.

Note Make sure not to create a hot folder in the folder or sub-

holders of the ColorGenius EX, as doing so may cause an

operation error.

5) Click the “Choose” button.

6) When you wish to store image files that have not been processed,

check the “Create a copy in BackupFolder in the hot folder.” check

box.

7) Select the hot folder type to be used from the “Hot folder type” pop-

up menu.
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8) When you select “Image + context (template)” or “ICC-Profile

(template)”, designate the recipe file or the destination profile to be

associated with the hot folder.

Click the “File” button.

9) Select the file and click the “Open” button.

10) Click the “Quit” button.

Button Function

Performs image processing by dragging and

dropping a folder that contains an image file

and a recipe file onto the hot folder.

Automatically performs calibration by

dragging and dropping a folder that contains

an image file, which is embedded an ICC

profile (source profile), and destination

profile onto the hot folder.

Automatically performs image processing by

just dragging and dropping an image file onto

the hot folder. This requires associating a

recipe file and destination profile with a hot

folder beforehand.

Image +

ICC-Profile

(folder)

Image +

context

Image + context

(template) or

Image + ICC-

Profile (template)
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4.2 Client setup
1) Launch the client application.

2) From the “File” menu, select the “General setup” sub-menu under

“Preferences”.

3) Check the “Use server assistant when the server is connected.” check

box.

4) Set the port number.

Specify the same number as you set for the server assistant.

5) Click the “Apply” button.

6) After restarting the server assistant, server application and client

application (following the order as described here), link the server

assistant application and the client application to the server

application. For detailed information, refer to “1.3 Linking the client

and server computers”.
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5. FT-S5500 setup
Clicking the “Settings” button in the setup palette window displays the

FT-S5500 Options window for the FT-S5500 scanning operation setup.

In this window, the resolution used during prescanning and the image

quality during scanning can be adjusted.

Setup regarding prescanning
This section describes how to set the resolution, image mode, and

scanning area used during prescanning.

1) Click the “Setting expand” button in the setup palette window.  The

“FT-S5500 Options” window appears.

2) Click the “General” tab.

3) Select the resolution to be used for prescanning with the Resolution

menu.

You can select the resolution from 36, 72, 144, 216, and 288 dpi.

4) Select the image mode from the Mode menu.

Select the image mode for the images that are to be input into

ColorGenius from a scanner. Usually, select “RGB (16 bits)”
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5) Select the scanning area to be used for prescanning with the Prescan

Area menu.

If you select A3, prescanning is performed over the entire area of the

scanning glass.  Besides A3, you can choose A4, 1/3, 2/3, 1/6, 2/6 or

Auto, and prescanning is performed respectively on the area as

shown below.  If you select Auto, after the positioning and sizes of

the originals are recognized, prescanning is performed on the

minimum rectangular area that encompasses all the originals.

A4 1/3 2/3

1/6 2/6 Auto
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6) Click the "OK" button and close the "FT-S5500 Options" window.

7) If the "Auto Trimming enable" check box on the right bottom side of

the window is not checked, the automatic trimming setting is invalid.
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Setup regarding the image quality when scanning is performed
By changing the scanning speed for scanning, you can select whether

priority is given to image quality or processing speed.  In addition, the

strength of the filter effect that is used during Manual Setup can be

adjusted.

1) Click the “Setting expand” button in the setup palette window.  The

“FT-S5500 Options” window appears.

2) Click the “Tune Up” tab.

3) Clicking and selecting the “Enable high productivity mode” box.

If you check this box, scanning is performed with a faster scanning

speed allowing you to reduce the scanning time, but with a lower

quality image.  If this check box is not marked, although scanning is

performed with a slower scanning speed, it will allow you to obtain a

higher quality image.

4) Select the “Disable auto focus on low-reso scan” box.

If you check this box, focus adjustment is not performed before

scanning when the input resolution is 800 dpi or lower.  If this check

box is not marked, focus adjustment is always performed before

scanning regardless of the resolution setting.
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5) Select the type of the filter to be used during scanning, and specify

the filter effect strength.

Select the type of filter from “Defocus” or “None (no filter to be

used)”.  When you select “Defocus”, adjust the filter effect strength

with the slider.

FT-S5000 allows you to select “Smoothing” in addition to

“Defocus”.

Filter Contents

Defocus filter When scanning a screened original like

printed material in high resolution,

ColorGenius may reproduce the image

preserving the clarity of the dots.  Using the

defocus filter to the image will reduce the

clarity of individual dots and produce a

smoothed image by defocusing the pixels

in the overall image.

Smoothing filter* Reduces film graininess or noise that is

generated during scanning at a high

resolution.

*: Only for FT-S5000

6) Click the “OK” button, and close the “FT-S5500 Options” window.



ColorGenius EX USERS MANUAL

2 - 34

6. ColorGenius default setup
In the Preferences dialog box, you can specify the Scratch disk to be used

when an image of a large amount data is handled, the file for storing the

parameter files and profiles that are used for setup, and also the default

unit.

Moreover, you can choose whether or not to use ColorSync, to display the

simulation window(s), to use window animation, and whether or not to

display the driver alert.

6.1 General setup
1) Launch ColorGenius.

2) From the “File” menu, select the “General setup” sub-menu under

Preferences”.

Scratch disk setup
The Scratch disk is a disk space to which data is temporarily saved when

there is not sufficient RAM memory to handle a large image or other data

intensive file.  The Scratch disk pop-up menu displays other volumes

besides the launched disk.  Select a volume with a high processing speed

and large capacity for the Scratch disk.
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To set up the Scratch disk:

Select the disk you wish to use as the Scratch disk from the Scratch disk

pop-up menu.

Default unit setup
Select the default unit in which the size of the image is inputted as mm,

inches, or customized unit.

Units specified here will be applied to values in the file information and

rulers displayed in the image window and values in information palettes.

To select the unit to be used:

Select the unit to be used from the “Default unit” pop-up menu.

Customized unit:

Select “customized unit” when you wish to use a unit other than mm,

inches, or pixels.  Then, enter the value of the customized unit in terms of

mm units in the “”mm” equivalent” box.

Note The unit to be selected here is the unit displayed as the

default.  You can change the unit as you wish with the “Unit”

sub-menu of the “Image” menu  after the Image window

appears.

Use preview icon

If you check this box, the image preview icon is used for newly saved

image files.

Font size in Setup Palette

The font size for the Setup Palette can be set at 12, 10 or 9 points.

File creator

If you check this box, an application you select can be set as the creator

for newly saved image files.  Accordingly, double-clicking on a saved file

will open it with the application set as the creator.
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Display driver alert.

If you check this box, the contents of an error that has been generated

with the FT-S5500 is displayed on the client machine.

Use the high-resolution preview display.

If you checkmark this box, the preview window displays a high-resolution

image.

The digitized dimensions of an image are set in “High resolution preview

image size” and this image appears in the preview window. The higher

the set value is, the finer the displayed image will be.

This function is useful when you scan a small original such as a 35 mm

film.
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6.2 Setup environment
1) Launch ColorGenius.

2) From the “File” menu, choose the “Setup environment” sub-menu

under “Preferences”.

Use ColorSync.

To use ColorSync, “ColorSync Extension” of the System Folder’s

Extensions and “ColorSync” of the Control Panels must be activated.

Note Refer to the next section, “6. Calibration,” for ColorSync

setup.

ColorSync Ver.2.1 or higher must be installed in the system.

Display preview image in sharpness fine adjustment section.

If you check this box, the simulation window(s) for displaying the

sharpness effect will appear in the Sharpness tab of the Easysetup: Fine

adjustment dialog box.

Use Sharpness preview

If you check this box, the effect of sharpness settings (sharpness preview)

is shown in the edit window when the “Preview” option is checked in the

setup palette window.

Clicking “Sharpness preview adjust” opens a dialog box where the

settings for the sharpness preview display can be adjusted.
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When the display magnification of the edit window is changed between

16 times magnification and one sixteenth size reduction using the zoom

tool, the effect of sharpness settings can not be accurately previewed for

such different magnifications when using the same setting for the

sharpness preview.  In such cases, the sharpness preview setting should be

adjusted in this dialog box.

Specify the mask size and gain value for each magnification setting, from

16 times larger to one sixteenth smaller.  The mask size adjusts the image

outline width affected by the sharpness function, and the gain value

adjusts sharpness strength.

Clicking the “Save” button stores the sharpness preview settings

Clicking the “Reset All” button restore all settings to their default values.

Preview accuracy

The speed and quality of the preview display can be selected here.

Optimized for speed The preview is displayed more quickly though

its quality is lowered.

Normal The preview quality becomes higher though

the display speed is slower.

Image handling parameter preference
For detailed information, refer to “1.3 Editing image handling parameter

preferences” in chapter 4.
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Editing Negative AI film parameter
For detailed information, refer to “1.4 Negative AI film parameter edit” in

chapter 4.

6.3 Setup customize
Sharpening effects can be adjusted depending on the settings for

magnification and resolution.

(For more detailed information, refer to “1.5 Sharpness customization” in

chapter 4.)

6.4 Entry key word
Select a keyword for Easy Setup.

Using the entry key word setting window, you can hide the key words

that are not used very often or show only the key words that are

frequently used on the setup palette.

1) From the “File” menu, choose “Entry keyword change” sub-menu

under “Preferences”.

2) Drag and drop each key word to be displayed on the setup palette

from the “Not entered” list to the “Entries” list, or drag and drop each

one to be hidden from the setup palette from the “Entries” list to the

“Not entered” list.
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7. Color calibration setup

7.1 About ColorSync
ColorGenius supports the color matching system by using ColorSync.

What is color matching?
If color management is not performed, when the color original read by a

scanner is displayed on a monitor or output to a printer, colors appearing

on the output image could differ from the ones on the original. This is

because each input or output device (i.e., scanners, monitors and printers)

uses a different color space (RGB, CMYK, etc.) and has different

characteristics for reproducing colors.

Color matching is a way to ensure consistent color between the devices

by assimilating the differences in color spaces and color reproduction

characteristics in each device.

Color Management System

In the computer world, where digital data is used, Color Management

System (CMS) application programs are becoming the prominent method

for achieving color matching. The CMS called ColorSync is preinstalled

as standard on the Macintosh OS, while ICM is preinstalled on the

Windows OS, and most application software which utilize color image

data also aim at facilitating color matching using such CMS.

R G B R G B C M Y K

Color matching is a way to ensure consistent color reproduct 
between all devices in the chain from input to output
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ColorSync color management
To comprehend the function of ColorSync, it is necessary that the user

understands the following two keywords: device-independent color and

device profiles (ICC profiles).

ICC is an abbreviation for International Color Consortium®.

Device-independent color

Device independent color aims at reproducing colors using a color space

that is not dependent on any device. The CIE XYZ (Lab) color space

defined by CIE (in English: The International Commission on

Illumination) is the standard device-independent color space used

internationally in color management. When transferring color data

between the input/output devices (i.e., scanners, monitors and printers), a

consistent color reproduction can be made by first translating color data

into the XYZ data that is not dependent on any device. (Refer to Chapter

1.)

Note Conventionally, the XYZ-dimensional representation of a color

is used to express the light emitting colors on a monitor; while

the Lab representation of a color is used to express the

physical colors on a reflective or transparent original.

Because the color representing values between these two

systems are interchangeable, both can be used as

equivalents by utilizing a simple formula.

R G B

R G B

X Y Z

By converting certain RGB values into 
the device-independent color space data 
(XYZ data), you can maintain color data 
with absolute values.

Even when a color is represented using the same RGB values, the color 
appearing on each device may vary due to the unique characteristics of color 
reproduction of each device.
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ICC profile

An ICC profile is a file in which the characteristics of color reproduction

for each unique input or output device (i.e., a scanner, monitor or printer)

are described.

ICC profiles, in addition to being preinstalled in the Mac OS, are

generally attached to the products of input/output device manufacturers,

and their latest information is available to the public on the Internet.

ICC profiles can be created and customized using LabFit.

ICC profiles can be classified according to the following three types:

• Scanner profile: The scanner profile is a file that stores information

pertaining to the range of colors and output characteristics of the RGB

data input from a scanner. With regard to the scanner profile,

ColorSync converts the input RGB data into the Lab data.

• Monitor profile: The monitor profile is a file that stores information

pertaining to the range of colors and output characteristics of the

monitor. ColorSync converts the Lab data into the RGB data that

matches the characteristics of the monitor.

• Printer profile: The printer profile is a file that stores information

pertaining to the range of colors and output characteristics of the

printer or the printing machine. Before displaying the finished image of

printed material on the monitor, select the printer profile that matches

the printing conditions.

Functions of ColorSync

When importing color image data from a scanner, for example,

ColorSync will convert the scanner’s RGB data (device color) into the

XYZ data by referring to an appropriate scanner ICC profile. To output

the XYZ data into the printer, ColorSync will then convert the data into

the printer’s CMYK data (device color) by referring to an appropriate

printer ICC profile.

In this manner, ColorSync maintains color consistency between the input/

output devices by using an ICC profile (that matches with each input/

output device) during conversion when importing the device color from

the input device (converting it into the XYZ data) or when exporting this

XYZ data to other devices (after converting it into the appropriate device

color.)
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Features of color matching
Even if a color matching system is used, the color of printed materials (or

originals) and their images on the monitor cannot be fully matched due to

the limitation of the color reproduction range (gamut), which differs

according to the device used. Within this limited range, a perfect color

matching is unattainable.

Also, even if an accurate ICC profile is used, the result depends to some

extent on room environment and adjustment status of device; in some

cases, an accurate color matching result is not possible. Arrange your

room environment and adjust your device as follows:

Room environment

Effects of exterior daylight

...... To perform a color proof for printing materials on a monitor,

perform the operation under conditions that reduce the effect of

exterior daylight as much as possible. If there are windows, use

curtains to shield the exterior daylight, and cover the monitor

display with a monitor hood to further decrease the effect of

room light.

R G B

Input profile
(scanner profile)

Printer profile

Monitor profile

ColorSync

CIE XYZ
color space

RGB data
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Illumination

...... It is very important to perform the color proof operation in a

room where constant brightness and color temperature are

always maintained. We also recommend that you use quality

fluorescent lamps with the best possible fidelity for interior

lighting (equivalent to an AAA daylight color regulated by JIS).

When you compare the image colors on the printed materials

with the ones on the monitor, we recommend that you use a

merchandised viewer.

Device adjustment

Color reproduction by devices is unstable due to wear and tear over time

and to differences among devices. We recommend that you periodically

adjust (calibrate) devices using colorimeter; printers, in particular, need to

be adjusted at least once a day.

7.2 ColorGenius’s color calibration
In ColorGenius, DSstdRGB is used as an

RGB color model that is suitable for

image processing.

The DSstdRGB data is directly input

from the FT-S5500 and converted into

CMYK (or RGB, or Grayscale) data,

according to an “output profile” (This is a

dedicated profile of ColorGenius and is

different from ICC profiles.), for printing.

There are several “output profiles,”

depending on the original type and output

condition, and these profiles can be

selected from the setup palette window.
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The basic characteristics of color reproduction is determined by an

“output profile.” AI Setup and other fine adjustments follow after this.

An “output profile” can be customized to conform to printing conditions.

(Refer to Chapter 5 “Using the Make Profile Tool”.)

In ColorGenius, in addition to the above conversion, the following

operations are available using ColorSync:

To perform simulation on the monitor

• The color of scanned originals can be reproduced in the preview

window.

When the “Preview” check box is not checked in the setup palette

window, the scanned images are displayed as accurately as their

originals in the preview window after the characteristics of the monitor

FT-S5500

RGB CMYK

Printer
calibration
conversion

Execution
of setup

processing

AI setup,
fine adjustment,

etc.

Printing, etc.
ICC

CMYK

Output profile

ONOFF
Preview

Monitor simulation

Monitor profile

Press profile
(Printer profile)

ICC

Embed

Embed

Color printerOutput of proof

DS std RGB
(Scanner 

profile)

DS std RGB

Scanner
profile

Scan

RGB

IC
C

Other scanner,
digital camera, etc.

DestinationSource

ICC profile

Conceptual rendering of
color calibration in ColorGenius

(For CMYK output)

Calibration conversion 
when importing images

Calibration conversion
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are calibrated according to the designated monitor profile. Select the

monitor profile which matches the monitor to be used from the profiles

installed in your Macintosh.

• The FT-5500 has been calibrated using a commonly available type of

positive film and printing paper (photo). Therefore, accurate

reproduction cannot be achieved in some cases, depending on the

original type.

• Finished images of printing results can be simulated in the preview

window.

When the “Preview” check box is checked in the setup palette window,

the setup processing is simulated and the color of the printing result

and the characteristics of the monitor are calibrated using the press

profile (printer profile for output is referred to as “press profile” in this

manual), and then images are displayed in the preview window.

A press profile is linked to an “output profile.”

To execute calibration when importing image files

When importing image data with a scanner other than the FT-S5500 or a

digital camera, a scanner profile is used to convert the RGB data to

DSstdRGB data, which is as accurate as the original color. This

conversion is required because the correspondence of color data values

and actual colors are different from the FT-S5500.

Select the scanner profile from the profiles installed in the Macintosh or

use the profile embedded in the image. (Embedded profile is only

available with TIFF format file.)

To create a printer-calibrated image for proofing

When executing setup processing, in addition to the usual output image, a

calibrated image can be created for a specific printer. For the file name of

the image, “.o” is added and saved.

Sample-005.tif .............. Usual image file

Sample.o-005.tif ........... Printer calibrated image file
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The image is converted so that it reproduces the color of the printing

result using the press profile and printer profile, which is to be used for

the proof printer.

Select the printer profile from the profiles installed in the Macintosh.

A printer profile can be embedded in an output image. (Embedded profile

is only available with TIFF format file.)

The following ICC profiles are to be installed in the ColorSync Profiles

folder when installing ColorGenius.

ICC profile File name Contents

Scanner profile 5000stdRGB Profiles required to convert the DSstdRGB data

into the L*a*b* data.

Printer profiles JapanColorDS Profiles required to convert the CMYK data into

the L*a*b* data with the assumption that the

printing will be implemented with inks

commonly used in Japan for printing.

EuroDS Profiles required to convert the CMYK data into

the L*a*b* data with the assumption that the

printing will be implemented with inks

commonly used in Europe for printing.

SWOPDS Profiles required to convert the CMYK data into

the L*a*b* data with the assumption that the

printing will be implemented with inks

commonly used in the U.S.A. for printing.

Monitor profile

GDM2000TC

PressView21

BARCO

PCD321
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7.3 Settings of ColorSync
If you check the “Use ColorSync” check box within the “Preferences:

Setup environment” dialog box, you can display the calibrated image on

the monitor using the functions in ColorSync and you can calibrate image

file.

Selecting profiles
Select the profile to be used in the “ColorSync setup” window.

1) Select “ColorSync simulation…” from the Environment menu. ICC

profiles in the ColorSync folder are displayed on the profile list.

Displays detailed 
information of the 
selected ICC profile.

Filtering

Profile list
Drag and

drop
the profile.

CMYK model
    RGB model
         Grayscale model
                    Scanner profile
                         Monitor profile
                              Printer profile
                                       Modifies the profile list to the latest information.
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2) Drag and drop the scanner profile, monitor profile and printer profile

that are displayed on the profile list to the corresponding “Input

calibration conversion” “Monitor simulation” and “Printer calibration

conversion” boxes.

3) Click the “Quit” button.

To use the filtering function:

The filtering function allows you to group the ICC profiles stored in the

“ColorSync profile” folder into the following groups on the profile list. A

certain grouping of profiles is activated when the button is selected and

deactivated when the button is deselected. Click the button to switch

between activating and deactivating the function.

• Device type ............ Displays the ICC profiles related to the scanner,

monitor or printer when the corresponding button

is selected.

• Color model ........... Displays the ICC profiles related to the CMYK,

RGB and grayscale models when the

corresponding button is selected.

• File name ............... Displays the ICC profiles as file names when this

button is activated.

• Description ............. Displays the ICC profiles as the descriptions saved

in the ICC profiles when this button is activated.

Calibrate file when imported

When importing RGB images with a scanner other than the FT-S5500,

calibration is executed according to an ICC profile.

Displays only the RGB model.

Displays the ICC profiles 
for printer and monitor.
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When the “Check whenever opening files” check box is checked, the

dialog box, which enables you to select the scanner profile, will appear

whenever opening image files.

When the “Priority is given to the add-on profile. (TIFF)” check box is

checked, the embedded scanner profile in the TIFF file is forcefully

converted.

Performing monitor simulation

Enables you to perform monitor simulation by simply checking the check

box.  The simulation target varies as follows depending on the status of

the “Preview” check box in the setup palette window.

Preview check box Simulation target

ON Simulates the output status on the monitor.

OFF Simulates the color characteristics of the scanner.
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Note When simulating the color characteristics of the scanner,

whether the correct color is reproduced depends on the type

of original document.

Press profile

Sets the color characteristics (ICC printer profile: To distinguish this

profile from the profile for printer calibration described below, this profile

is referred to as “press profile”.) for printing of images output from

ColorGenius. A press profile is referred to during such operations as

monitor simulation and printer calibration.

The ICC profile can be set by the two setting methods described below.

• To always use the same printing condition

• To link to the ColorGenius conversion profiles (An ICC profile is

linked to an output profile.)

To always use the same printing condition:

1) Click the “Press profile” radio button.

2) Select the press profile.

To link to the ColorGenius output profile:

1) Click the “Linking with output profile” radio button.
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To change the link with the press profile:

When you wish to change the link between the ColorGenius output

profile and the press profile, follow the procedures described below.

1) Copy the press profile to the “ColorGenius ICC” folder.

2) Click the “Linking with output profile” radio button.

3) Click the “Change setting...” button.

The “Link between the mode profile and the ICC” will appear.

Note Clicking the “Change setting…” button while holding down the

Option key enables you to specify the ICC profiles for RGB

output and grayscale output in the “Link between the mode

profile and the ICC” window.

4) Select the output profile.
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Displays the 
detailed 
information 
of the ICC
 profile.

Filtering

Profile list*

Links the 
output profile 
and the press 
CMYK profile.

Displays the ICC profiles included in the “ColorGenius ICC” folder 
except for the profiles that are included in the ColorSync Profiles 
folder in the System folder.

* ..............

Drag and
drop

the profile.

5) From the profile list, drag and drop the press profile onto the “Press

CMYK” box.
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Creating a printer-calibrated image for proofing

Checking the check box enables you to output, in addition to the usual

output image, a calibrated image file that is matched to the color

characteristics of the printer specified. “.o” will be added to the file name

of the additional printer-calibrated image file. You can output the image

with a color printer and use it for proofing.

When the “Check whenever saving/registering files” check box is

checked, the dialog box, which enables you to specify the ICC profile,

will appear whenever you save the image files. The printer profile can be

changed when you save the image files.

Printer-calibrated image file (“.o” is added to the file name)
Usual image file

Clicking the “Register” button displays the dialog box for the conversion. 
In the standalone environment, this dialog box is displayed when 
selecting “Save as…” from the File menu.

Clicking the “Convert” button outputs a calibrated 
image file, in addition to the usual image file.
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Add this profile in the image. (TIFF)

Checking the “Add this profile in the image. (TIFF)” check box embeds

the printer profile in the output image file. The printer profile can be

embedded only in TIFF image files and not in other file formats.

Relation between the windows and the profiles

The figure below indicates the relation between the windows and profiles.

Please refer to the figure when setting the profiles.

Monitor

Monitor-
calibration

Setup
ColorGenius

FT-S5500

Scanner-
calibration

 Other
scanner or
image file

Printer-
calibration Printer

Standard 
RGB

D

S

CMYK

CMYK that matches 
the color characteristics 

of the printer

Specified on this 
section of the 
“ColorSync setup” 
window.

Automatically changes depending on 
the selected input device.
Example) When the FT-S5500 is 
                selected, 5500StdRGB is set.

Linked with the output profile. Specified on this section of the 
“ColorSync setup” window.

............ Source profile

............ Destination profile

Output profile
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8. Setting for performance improvement
When multiple originals are processed, the “scanning => execution of the

setup calculation => saving” sequence is repeated between the

ColorGenius and the FT-S5500.

The processing performance (productivity) will improve if the setup

calculation is executed during scanning.

This function can be set with the setting method described below.

Note Do not use this function when your Macintosh provides low

throughput, the network traffic (data transmission speed) is

extremely low, or you output data to a low speed volume like

an MO.

1) Perform scanning, then note down the processing time per pixel,

which is displayed in the Log window on the server application.

Note This function is inactivated when the following operation is

executed. At this time, the processing time will not be

displayed.

Rotate, Resize, Crop, Selected color modification, Custom

sharpness, Line art, Dot Finder (option), deMoiré (option),

Server assistant operation and Printer calibration image

creation.
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2) Choose “Preference” from the “Preference” menu.

3) Checkmark the “Setup calculation during scanning” box.

Restart the server application.

4) Click the “Setting expand” button in the setup palette on the client

application.
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5) Click the “Scan speed” tub.

6) Round off the value noted down in step 1) above and input this value

for “ColorGenius process per 1 pixel” field.

7) Click the “Update” button so that the appropriate value will be set as

the “Scan speed down-ratio”.

8) Click the “OK” button.

If the FT-S5500 operation repeatedly starts and stops during

scanning, set a smaller value as the “Scan speed down-ratio”.

If the FT-S5500 operation still repeatedly starts and stops even after

setting the smallest possible value as the “Scan speed down-ratio”,

deactivate the setting in step 3) above to cancel this function.

End of  Chapter 2
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Chapter 3  Understanding basic setup procedures

There are two methods for setting up input images with ColorGenius -

Easy Setup and Manual fine adjust.  Using the Easy Setup method,

images can be optimally processed simply by selecting the desired

properties from each of the three categories: image type, appearance and

color mode.

This chapter describes how to use the Easy Setup method.  The use of

Easy Setup in a client/server environment or a multi-client/server

environment is described in section 1, while section 2 explains its use in a

standalone environment.  In section 3, fine adjustment procedures using

the Easy Setup palette window are described.

Section 4 explains the fine adjustment procedure using manually entered

values.

1. Easy Setup in a client/server environment or a multi-client/

server environment
The following explains the setup procedure when computers (client and

server) are networked together and an FT-S5500 scanner is connected to

the server using a SCSI interface.  Before starting this operation, make

sure that the settings for the client/server environment and the network

have already been completed.  For detailed information, refer to the

following sections in Chapter 2: from “1. Client/server environment

setup” to “3. Multi-client/server environment setup”.

1.1 Starting the program

Linking client and server
Launch the server application on the server computer and the client

application on the client computer, and link these applications.

For details on how to link client and server applications, refer to the

following sections in Chapter 2: from “1. Client/server environment

setup” to “3. Multi-client/server environment setup”.

Use of originals
Open the top cover of the FT-S5500 and place the original on the glass.

For more information concerning the use of originals, refer to the FT-
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S5500 Users Manual.

Configuration of ColorGenius screens

Note Select whether or not to display any of the palettes, i.e. the

information palette, setup palette, or server management

palette, that can be selected under the “Window” menu.

e.g.) • If you want to display the information palette

windows, select “Show info” from the “Window”

menu.

• If you want to hide the information palette windows,

select “Hide info” from the “Window” menu.  (Or click

the close box on the upper-left corner of the palette

window.)

Information palette window:

While the Image window is displayed, the cursor position in the image,

the selected area’s X and Y axis information, and color information are

displayed.

Note For information on color models, refer to “Processing images

with tools” in the “1.4 Setup essentials” section.

The X and Y axes of the cursor 
position are displayed.

When an area has been selected, 
the lengths, i.e. the numbers of 
pixels in the X and Y directions of 
the selected area, are displayed.

The color information at the 
cursor position is displayed.  You 
can select which color model’s 
information to display via the 
Show Color Info menu.

Close box
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Setup palette window (Easy Setup palette window):

This is used to enter choices concerning the image type, appearance and

color mode categories.

Note These setup settings can also be chosen on the prescan

window, but the preview function can not be used.

Selects an input device
 (scanner).

Selects an original type.

Sets various details for 
the input device.

Sets the resolution and 
magnification for scanning.

Selects the trimming fields 
you want to lock.

Sets up details for trimming.
Selects whether or 
not to display preview 
images 
(post-setup images).

Clicking on this mark 
extends or abridges
the information.

Selects a output 
profile mode.

Selects an output mode 
(CMYK, RGB, Gray, Bitmap)

Opens the “Manual fine 
adjustment” dialog.
Opens the “Learning settings” 
dialog.

Opens the “Output settings” 
dialog.

Registers (Sends) the current setup file.

Opens the 
“Easy setup: 
Fine adjustment” 
dialog.

Sets the settings related 
to local storage.
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Server Management palette window:

After you decide the setup method, this palette window allows you to

check the state of file already sent to the server and monitor standby

information.

List of files on hold

Shows the file
being setup.

List of files standing
by
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(When using server assistant environment)

(When using client/server environment)

Lasso tool
Crop tool
Magnifying glass tool
Color picker tool
Trimming tool

Selection tool
Elliptical marquee

Hand tool
Rotation tool

Al tool

Tool box
When the Image window is active, the following tools are contained in

this box:

Note Refer to “Processing images with tools” in the “1.4 Setup

essentials” section for information on using the tools.
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1.2 Inputting images
The following shows how to input images to ColorGenius after prescanning

originals with the FT-S5500.  Prescanning means that the Original Tray on

the FT-S5500 is scanned at low resolution (selected from 36/72/144/216/

288 dpi).  You can check where the originals are positioned on the scanning

glass, by viewing them on the client via the server.

In addition to using images input from the FT-S5500, it is also possible to

open image files input or saved from another scanner.

Note For how to set the resolution for prescanning, refer to “Setup

regarding prescanning” in the “4. FT-S5500 setup” on Chapter 2.

Selecting the type of input original
Before starting prescanning, you must choose the input type.  There are

six types of originals; Positive film, Negative film, Photograph, Printed

material, Water color, Lineart (reflection), and Lineart (transparency) and

so on.

The light source used for scanning by the FT-S5500 will be determined

by the type of input original chosen.  If Positive film, Negative film, or

Lineart (transparency) is selected, scanning is performed using the

transparency light source.  If Photograph, Printed matter, or Lineart

(reflection) is selected, the reflection light source is used.  Note, if the

type of input original is set incorrectly, a proper scan is impossible.

To select the type of input original:

Choose one of the original types from the “Original” menu in the setup

palette window.

Note For details on inputting linework, refer to Chapter 6 “Line Art”.
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Starting prescanning
Click “Prescan” in the setup palette window.  The FT-S5500 starts

prescanning, and when it is finished, the Prescan window appears.

Note If you change the type of original to be scanned from

transparency to reflection (or vice versa), ColorGenius will

need approx. a 3-minute standby before stabilizing the light

amounts from the new light source.  In such a case, the

Standby dialog box, in which real time is indicated, appears,

and prescanning is performed when the light amounts

become stabilized.

If you click on the “Enforce” button while selecting the

Standby dialog box, you can execute prescanning even when

the light amounts have not been stabilized yet.  However, if

you execute prescanning just after the alternative light turns

on, you cannot acquire a high quality image.
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1.3 Trimming
FT-S5500 has the ability to recognize the position of the input original

automatically from the received amounts of applied light penetrating

through the original or the applied catoptric light from the original during

prescanning.  With this feature, if you set multiple originals on the FT-

S5500, trimming for these originals can also be done by recognizing the

positions of each of the originals automatically.  However, in some cases,

since the trimming area may contain unnecessary portions around the

original, you are required to modify the trimming to the individual

original so as to acquire an exact trimming area.  The areas specified in

this trimming will be the areas that are actually scanned.

Two trimming methods can be used: the Trimming tool, or values directly

input to each relevant field in the detail trimming setting dialog.

Modifying a trimming area
If you set multiple originals, trimming areas for each of these originals are

displayed in the Prescan window.  Choose the trimming tool and click the

original for which you want to modify the trimming area.  The color of

the dotted line indicating the trimming area turns green.  When you point

the cursor to any corner or side of the rectangular box, the shape of the

cursor will change and you can then modify the selected area.  Dragging

the mouse with the cursor in the center of the selected area allows you to

move the entire selection in any direction.

If you want to modify the trimming area of other original, select the

original (the area will be shown in a green dotted line) and modify the

position of the selected area following the same procedure as the above.

Note In the prescanned image, you can enlarge or reduce the

image (with the magnifying glass tool), scroll the visible

Trimming tool
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portion of the image (with the hand tool) or modify the color

information of the pixels in the image (with the color picker

tool).  For details, refer to the “Processing images with tools”

in the “1.4 Setup essentials”.

You cannot use the trimming/lasso/clip/rotation/AI tools in the

Prescan Window.

Add or delete the trimming area
You can add a new trimming area other than the area which has been

recognized automatically or delete unnecessary portions of the trimming

area.

To add a trimming area:

If you position the cursor in a place other than the trimming area in the

Prescan Window, the cursor changes to a cross-hairs cursor with a + mark

next to it.  In such a case, positioning the cursor at a start point, dragging

the mouse to the desired point and releasing it will allow you to set a new

trimming area.

To delete a trimming area:

If you press the Option key, the cursor changes to the cross-hairs cursor

with a - mark next to it as seen on the left.

In such a case, clicking the mouse while placing the cursor within the

trimming area will allow you to delete the selected trimming area.

Note Note that if you click the mouse when placing the cursor

within an area other than the trimming area while holding

down the Option key all trimming areas are deleted.
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Trimming by inputting values
Click the “Setting details” button in the setup palette window.  A dialog

box appears and displays a number of fields for inputting the start point,

input size and output size.

In the “Start point” field, the distance between the origin on the Original

tray glass and the start point (upper left corner of the trimming area) is

displayed.  In the “Input size” field, the distance between the start point

and the end point (lower right corner of the trimming area) is shown.  The

measurement units of the start point and input size can be either “mm”,

“inches” or “Customized Unit”.  However, the measurement units of the

output size can be selected from among “mm”, “inches”, “pixels” or

“Customized Unit”.

At right of the individual “Magnification”, “Input size” and “Output size”

fields, lock icons are displayed, and one of them is shown locked.   If you

do not want to change the value in the field, lock it.

When you enter a value into either of the two unlocked fields, the other

value is automatically calculated and input while the value in the locked

field remains unchanged.  However, if you enter a value directly into the

locked field, the field becomes unlocked and one of the fields previously

unlocked becomes locked.

Note You can also specify the trimming fields you want to lock from

the setup palette window.

Clicking on the right-
angle arrows icon
displays a dialog box
for inputting the
horizontal or vertical
magnification values
individually.

If you enter a value
directly into the
locked field, the lock
is released and one
of the other
previously unlocked
items becomes
locked.
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To lock/unlock the horizontal to vertical ratio:

Clicking the perpendicular double arrow icon to the left of the

“Magnification” field displays an area with separate fields for horizontal

and vertical magnification, which you can then set individually.

An area with separate fields for entering horizontal and vertical magnifi-
cation individually.

Clicking on either of the double arrow 
icons changes the values for both 
horizontal and vertical magnification to 
the value of the chosen icon.

This shows the display area for individually setting both the horizontal

and vertical magnifications. To apply different horizontal and vertical

magnification ratios, leave this area displayed after the desired ratios are

entered in the respective fields.

If you subsequently click on either of the double arrow icons, it will

change this area back to the previous unified display and enter the value

to the right of the clicked icon for both the horizontal and vertical

magnification ratios.

In other words, leave the display area for individual magnification

settings open to apply different horizontal or vertical ratios, or click on

either double arrow icon to apply its value to both horizontal and vertical

magnification.
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When the magnification has been locked:

•  If the start point is changed, the trimming frame will move.

•  If either input or output size is changed, the other will change in

proportion to the magnification.

When the input size has been locked:

If you lock the input size while the horizontal to vertical ratio has been

locked, a chain icon will appear.  The horizontal to vertical ratio for the

output size won’t change.

• If the start point is changed, the trimming frame will move.

• If either the magnification or the output size is changed, the other will

change in proportion to the input size.

When the output size has been locked:

When the horizontal to vertical ratio has been locked and you lock the

output size, a chain icon will appear.  The horizontal to vertical ratio for

the input size won’t change.

•  If the start point is changed, the trimming frame will move.

•  If either the magnification or the input size is changed, the other will

change in proportion to the output size.

Edit window
When trimming is finished, click the “Confirm” button at the bottom of

the “Prescan” window or, click the “Confirm” button or double-click on

the trimming area in the Prescan window to enlarge the trimmed area.

This Image window is called the “Edit” window.  A lock mark appears in

the upper-left of the trimmed area on the prescan window to indicate that

the trimming area can not be modified.  At this point, you can create setup

data in the Edit window.

Note The setup can also be performed on the prescan window

(without pressing the “Confirm” button after the trimming area

is set), but the preview function.   Also, it is not possible to

setup the AI analysis area, or rotate, crop, or change the

image size. can not be used.
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Display in the Edit window

File information are displayed at the top and bottom of the window, as are

rulers at the top and the left sides. The file size is shown at the bottom of

the window, while the image dimensions are shown at the top.  This

information can be shown or hidden, using menu commands accessible

via the button at the extreme right of the top ruler.

Overlap display and line-up display

In the edit window, the pre-setup image (reference image) and post-setup

image are displayed at the same time.  Therefore, setup can be performed

while comparing those two images.

Clicking either of the two buttons (shown below) in the edit window

switches the conditions for two image display, between having the images

overlap or line up.

File information

Ruler

Shows or
hidea the
information
or the rulers
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Overlap display:

The pre-setup image and post-setup image overlap each other in the edit

window.

Clicking the “Pre-setup img.(Before)” button brings the pre-setup image

to the front.

Clicking the “Post-setup img.(After)” button brings the post-setup image

to the front.

Clicking the “After→Before” button replaces the pre-setup image with

the post-setup image.

Line-up display

Overlap display
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Line-up display:

The pre-setup and post-setup images are lined up on the right and left in

the edit window.

Clicking the “Exchange R/L images” button switches the position of these

two images.

Clicking the “After→Before” button, or dragging and dropping the post-

setup image to the pre-setup image while pressing the control key,

replaces the pre-setup image with post-setup image.

Opening an image file
You can also process image files in which images input from another

scanner are saved.  However, when setting up the image by opening the

file, the full setup commands are only used for the RGB image.

1) Select the “Open” command from the “File” menu.
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Note In the client/server environment, pressing the Option key

switches the “Prescan” button to the “File input” button in the

setup palette.

It is also possible to open an image file by clicking the “File

input” button.

2) Select a file and then click “Open”.  The image file will be opened.

Note When opening an image file in a client/server environment, its

low resolution image is displayed on the client as also occurs

when inputting the image from the scanner.

If the file contains more than 1MB of data, the number of

pixels in the image is reduced to 1MB or less, regardless of

the digital dimensions of the file.
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1.4 Setup essentials
When the trimming has been completed and the Edit window is

displayed, creation of setup data begins.  When trimming multiple

originals sequentially in the Prescan window, click inside the image you

want to start setup on (the outer edge of the trimming area turns green),

and then click the “Confirm.” button.  The Edit window is displayed.

Processing images with tools
Using the tools contained in the Tool box, you can perform image

selection, cropping, magnification/reduction, scrolling, color selection,

rotation, trimming and setting the area for AI analysis.

Selection tool:

Selects a rectangular area.  Selecting this tool changes the cursor to a

cross-hairs cursor in the Image window.  Placing the cursor at a start point

and dragging the mouse in any direction displays a rectangle with a dotted

line.  When you release the mouse button, the area in the rectangle will be

selected. After selecting an area, when you move the cross-hair cursor

into the area, you can drag the area in any direction.  Commands for

rotating the image can be executed after selecting the area with this tool.

Commands for rotating the image can be executed after selecting the area

with this tool.

You can draw a square area by dragging this tool while you are holding

down the shift key.

The table below lists the keys that are held down while you drag this tool

and the respective results.

Selection tool

Elliptical marquee

Hand tool

Lasso tool

Color picker toolRotation tool

Magnifying glass tool

Trimming toolAI tool

Crop tool

Connect button
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If you select “Target reverse area” from the “Edit” menu, the area outside

of the previously selected area will be selected.

Lasso tool:

Allows you to designate a selected area freehand.  Selecting this tool

changes the cursor to a lasso in the Image window.

Placing the cursor at a start point and dragging the mouse displays dotted

lines which track the movement of the cursor.  When you release the

mouse button after drawing an arbitrary shape and returning to the start

point, the enclosed area will be selected. (If the area is not closed, a

straight line between the start point and the end point will be drawn.)

After selecting an area, when you move the lasso cursor into the area, the

cursor will turn into an arrow, which allows you to drag the selected area

in any direction.

Note With this tool, you can add and delete selected areas as

performed with the selection tool.

Elliptical marquee:

Selects an elliptical or a circle area.

You can draw a circle area by dragging this tool while you are holding

down the shift key.

Note The area modification methods are the same as for the

selection tool.

Key to be 
held down Cursor shape Result within the area

Option key

Command key

Option
 + 

Command keys

The area where the currently 
selected area overlaps the 
previously selected one will 
be deleted.

The currently selected area 
will be added to the 
previously selected one.

The area where the currently 
selected area overlaps the 
previously selected one will 
be selected.
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AI tool

Selects an AI analysis area.

The AI analysis area will be displayed in the red frame.

Crop tool:

Selects a part of the image and discards the rest.  After choosing an area

you want to crop (in the same manner as the selection tool), a small

square box appears at each corner of the selected area.  Placing the cursor

on one of these marks and dragging the mouse changes the cropped area.

When you move the cursor into the selected area, the cursor turns into a

pair of scissors.  Then, when you click the mouse button, the area outside

the selected area will be erased.

Hand tool:

Scrolls the visible portion of an image when a magnified image is not

contained within the Image window.  Selecting this tool changes the

cursor to a hand. Scrolling is possible by dragging the hand in any

direction within the image.

Magnifying glass tool:

Enlarges or reduces an image.  Selecting this tool changes the cursor to a

magnifying glass, showing a “+” mark inside.  Placing the cursor in the

image and clicking it enlarges the display.  Press the Option key and the

magnifying glass will show a “-” mark.  Then, when you click the mouse

button, the image will be reduced. Each click will double or halve the

magnification.

Note that the center of magnified view will display the area where the

cursor was located when clicked.  The image can be magnified a

maximum of 16 times, or reduced to 1/16th of its original size.  When the

enlargement/reduction rate reaches its limit, the magnifying glass will be

blanked out.

When displaying an enlarged (or reduced) image, double-clicking the

magnification glass in the tool box restores the image to the default size.
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Rotation tool:

Rotates an image an arbitrary angle.  When you choose this tool, two

perpendicular lines with small square boxes at either end are displayed in

the Image window.

Place the cursor on any of the boxes and drag it in the direction you want

to rotate the image.  The cross formed by these perpendicular lines shows

the direction and angle of rotation.  After the angle of this cross mark

matches the intended degree of rotation, position the cursor near its

center. When its shape changes to a gavel or hammer, clicking the mouse

will finally rotate the actual image in the specified direction and angle.

The “Orientation” command mirrors the image vertically or horizontally,

or rotates the image by a specified angle.

To use the “Orientation” command:

Choose “Pre-setup/Rotate Canvas...” from the Image menu.

Using “Mirror/Orientation”, you can mirror the image or rotate it in 90-

degree increments.  The bird icon indicates that an original has been

either flipped or rotated.  Click the icon indicating the direction you want

to rotate or flip the image.

Selecting “Custom rotation” allows you to rotate the image simply by

setting the angle and direction of rotation.

Drag the square
box in the direction
you want to rotate.

These icons indicate an
image's possible
orientations (mirrored and/
or rotated).
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Color picker tool:

Displays color information about the pixel in the image that the cursor is

placed on.  The color information (both current information and after

setup) is displayed on the Information palette window.  The Color picker

tool is mainly used when setting the sharpen/unsharpen selected colors

during Manual fine adjustment, when measuring color information for a

multi-point palette, and when setting the “HD”/”SD” density during

Manual fine adjustment.

The information concerning the selectable color models is displayed on

the Information palette window.  Clicking the triangle mark on the color

information displays the selectable color models, and the color

information on the selected color models is displayed.

Color model Description

RGB R, G, and B separations are described in terms of tone

values ranging from 0 to 255 (for 8-bit color images)

or from 0 to 65535 (for 16-bit color images).

Gray The K separation is described in terms of density

values ranging from 0 to 100%.

CMYK C, M, Y, and K separations are described in terms of

density values ranging from -750 to 850%.

HSL Hue (H) is expressed as an angle on the standard color

wheel ranging from 0 to 360 degrees, saturation (S) by

a percentage ranging from 0 to 100% (gray to pure

color), and luminance (L) by a percentage ranging

from 0 to 100% (black to white).

Color informa-
tion after setup

Current color
information
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Displays color information.

• For CMYK or Grayscale images

Choosing any other mode is not allowed.  For a CMYK image, only

“CMYK” can be selected, and “8-bit color” or “16-bit color” can not.

• For RGB image

When outputting an image in CMYK mode, “RGB” or “CMYK” can

be selected.

When outputting an image in Grayscale mode, “RGB” or “Gray” can

be selected.

When outputting an image in RGB mode, “RGB” or “HSL” can be selected.

For 48-bit RGB images (16-bit color depth for each R, G and B), “8-bit

color” or “16-bit color” can be selected.

Clicking the Color picker tool displays the following menu, so that you can

change the sampling area.  3*3 sampling has been set by default.  Selecting 3*3

or 5*5 sampling displays the mean value of 9 or 25 pixels, respectively,

calculated from the center of the cursor position.

 Adding/deleting sampling areas
Adding sampling areas

Selecting the Color picker tool displays the multi-point palette and the

cursor changes to the color picker cursor, with a  + mark next to it.

By clicking an area with this cursor, up to 8 areas can be selected as

sampling areas.

The following items can
be chosen.

A number is shown to
the lower-right of the
image picker cursor.
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Deleting the sampling area

To delete sampling areas, press the option key.  The cursor will change to

the image picker cursor with the mark shown left.  Click a sampling area

you want to delete with this cursor.

Changing the image size and resolution
The input image’s resolution and size (width/height) can all be changed.

The relations between image size, resolution and file size are explained

below:

• Enlarging the image size (without changing the resolution) creates new

pixels based on the color information on the image, and thus increases

the file size.

• Reducing the image size (without changing the resolution) deletes

pixels from the image, and thus reduces the file size.

• Changing the resolution also changes the image size proportionally,

but does not affect the file size because the number of pixels remains

the same.

Shows color display and color information after modification

Multi-point palette
Displays the hues that can be corrected with CMYK color 
correction. (This palette will not be displayed for the RGB 
or Grayscale color correction.)

Shows color display and color information before modification
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To change the image size and the resolution:

1) Choose “Pre-setup/Image Size” from the Image menu.

2) Choose the desired measurement unit from the Unit menu.

3) Input the new values for width, height and resolution.

Checking the “Fixed ratio” option allows you to change the image

size while maintaining the same horizontal to vertical aspect ratio.  If

you subsequently enter a value into either field (width or height), the

other value is automatically calculated and input based on the

specified ratio.

Note When the image is input from the FT-S5500, you cannot

change the resolution of the images (the resolution field

doesn’t appear in the dialog box).
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Checking this box displays
the image after setup.

Selecting the image
Choose items from the “Image” menu in the Setup palette window which

correspond to the image in the original.  The choices in the “Image” menu

differ depending on the type of input original selected in the setup palette

window.  When the type of input original is other than Negative, you can

choose either General, Portrait, Scenery or Machines the “Image” menu

to the left.  More detailed setting can be selected from the menu on the

right.

When the type of the input original is Negative, the “Image” menu is

changed to the name of the film.  Select the film name from the menu to

execute the setup according to the film properties.



ColorGenius EX USERS MANUAL

3 - 26

Image

keyword Description

Standard Sets the highlight and shadow points to

standard values, and corrects the color

cast if one appears in the image.  This

is the standard setup function, which

should best preserve the tone and range

of the original.

Foods Removes the somberness of hue (red or

green) that meat or vegetables often

suffer from, finishing foods more

brightly, while maintaining most of the

standard settings.

Jewels Provides corrections so that jewels will

have a three dimensional effect and the

highlight areas will become more

glossy, by using a sharpness correction

in addition to the standard settings.

WhiteChinaware Sets the highlight point so that white

chinaware will look whiter, while

adjust sharpness so that the smoothness

of the surface will be enhanced.

To check the image after setup:

Checking the “Preview” box in the Setup palette window displays the

image that will be executed by the selected setup commands (image type,

appearance and output image mode).

Image keywords and descriptions

General
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Faded color Extracts unnecessary colors at the

highlight/shadow point, and corrects

the color cast by broadly removing

these color components.

Standard Since human flesh is comparatively

pale, if this is processed with standard

settings, the skin may become grayish.

This function invokes a color

replacement process for flesh areas to

reduce such color casts and finish the

image with brighter flesh colors.

Flesh intensive (Light) Slightly reduces highlight lightness

from the standard setup, and finishes so

that flesh colors won’t become pale.

As with the standard portrait setting, a

color replacement formula is used for

flesh areas.

Flesh intensive (Dark) Removes the color cast in a way

similar to the standard portrait setup,

and lightens mid-tones.  This function

also adjusts the sharpness to prevent

roughness of the flesh.  As with the

standard portrait setting, a color

replacement formula is used for flesh

areas.

Portrait

General
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Standard Removes the blue cast from the image,

since originals of scenery are, in most

cases, cast in blue.  The blue in leafy

scenery and the sky are clearly

represented using the color collection

function.

Night scenes Finishes the highlighted portions (such

as lights) slightly brighter while

maintaining the darkness of the

images.  However, since a night view

is illuminated by colored light, too

much whitening shall also be avoided.

Standard Sets the sharpness so that the edges in

the image are clear.  However, to

produce the sharp, cold feeling of

machines, this function adjusts the

thickness of the edges to create fat,

bold  lines around edges in the image.

Domestic

appliances

Retouches the surface of white/pale

domestic appliances to smooth them to

avoid a rough appearance.

Note “USER: 1”, “USER: 2”, etc in the “Image (detail)” menu are

spare keywords.  The settings for these items are the same

as those set for “Standard” before shipment.

Scenery

machines
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Selecting the finish
Drag and drop the keyword you wish to use from the “Finish (options)”

box to the “Finish” box in the Setup palette window.

Note • Several keywords can be selected from the “Finish (options)”

box.  Even if  conflicting keywords are selected at the same

time, such as “Slightly dark” and “Slightly light”, an appropriate

process will be carried out.

• If you register settings with the server and execute a setup

without selecting a keyword, the scanned image will be saved

without any finish processing.  The image will be output in

RGB mode.

• You cannot select “Standard” and other keywords

simultaneously.
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Finish styles and description

Finish style Description

Standard Does not add any correction.

Slightly dark Slightly darkens the mid-tones.

Slightly light Slightly lightens the mid-tones.

Bright Removes the somberness of the image, and

raises the saturation.

Sharp Strengthens the sharpness correction level.

Soft Weakens the sharpness correction level.

Solidity Darkens the mid-tones, and widens the

sharpness mask to thicken the contrast

boundaries.

Whitish highlight Finishes the highlights brighter.

Contrasty Emphasizes the contrast.

Original atmosphere Reduces the color-cast correction level to leave

the original pale colors.  This function is

suitable for originals taken under candle light

or special lighting sources.

Highlight dropout This raises the reference density of the

highlight.  Therefore, select this item, for

example, when scanning printed material and

you want the dots in blank sections of the

paper to be eliminated.

 Note “USER: 1”, “USER: 2”,etc in the “Finish(options)” menu are

spare keywords.  The settings for these items are the same

as those set for “Standard” before shipment.

Selecting the output image mode
Choose the mode that the scanned image will be converted to.  When the

input image is set to RGB mode, it can be converted to CMYK, RGB or

grayscale mode.

To select the output image mode:

Choose any image mode from the “Mode” menu in the Setup palette

window.
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Note When the original type is set to “Line Art” or “Dot Finder

(option)”, “Bitmap” is selected here.

When the input image is set to RGB mode, “CMYK”, “RGB” or

“Grayscale” can be selected for the output image, but when

set to CMYK or Grayscale mode, only the same mode can be

selected.

To select the output profile:

In ColorGenius, DSstdRGB data, which is an RGB color model

optimized for image processing, is converted to the CMYK data (or RGB

or Grayscale) according to the "output profile" (This is a dedicated profile

and different from ICC profiles.).

Choose any output profiles that match each original type and output

condition.

Note The "output profile" can be customized using the Make Profile

Tool. (Refer to Chapter 5 "Using the Make Profile Tool".)

It is also possible to reflect the settings specified by the

manual setup on the output profile (refer to “4. Manual fine

adjustment”).

CMYK

RGB
Graysale

BitMap
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The profiles shown below will be installed during ColorGenius

installation.  Choose the optimum profile for your type of printing ink.

Profile name Contents

• JColorDS_8bitV120.C5T A profile compatible with Japanese printed materials.

Use this profile when outputting 8bitRGB-format images.

This is the default profile.

• JColorDS_16bitV120.C5T A profile compatible with Japanese printed materials.

Use this profile when outputting 16bitRGB-format images.

• EURODS_8bitV120.C5T A profile compatible with European printed materials.

Use this profile when outputting 8bitRGB-format images.

• EURODS_16bitV120.C5T A profile compatible with European printed materials.

Use this profile when outputting 16bitRGB-format images.

• SWOPDS_8bitV120.C5T A profile compatible with North American printed materials.

Use this profile when outputting 8bitRGB-format images.

• SWOPDS_16bitV120.C5T A profile compatible with North American printed materials.

Use this profile when outputting 16bitRGB-format images.

Setting the resolution and the magnification
Set the resolution and the magnification for scanning.  Set the values of the

resolution and magnification (100%=1) individually so that the product of

these values remains within the range from 20 to 20000.  For example, if

you set the resolution to 400dpi, the potential magnification within which

you can set the value is 5 to 5000%.  In addition, since the number of

pixels which can be contained in each primary and secondary scanning

direction for the output image ranges from 16 to 30000, and from 16 to

30000, respectively, please note that the resolution and magnification must

be set so that the result will not exceed the allowable range.

To set the resolution and the magnification:

Directly enter the values in the boxes in the setup palette window.
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Setting file output
Set the name, destination, and other setup items for image files to be

output after scanning and setup are executed.

After the settings described below are all completed, click the “Apply”

button.

Click the “Output” button in the setup palette window.  The following

dialog box will appear.

File name:

Enter a file name in the “Base file name” box.

Counter number:

Checking the “Use counter no.s” check box puts a counter number at the

end of the file name.

The junction mark between the file name and the counter number can be

selected from among “-”, “.” ,“+” and “_”.

Select the counter number range from among “0001 to 9999”, “1 to

9999”, “001 to 999”, “01 to 99”, or “1 to 99”.

e.g.)When the base file name is “abc”, the junction mark is “-”, and the

counter number range is “0001 to 9999”.

1st file: “abc-0001”

2nd file: “abc-0002”

3rd file: “abc-0003”
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If you want to return the counter number to 1, click the “Counter Reset”

button.

Extension:

Set whether or not to apply an extension to saved file names.

Select one from among “None”, “Use “.” ”, and “Use “_” ”.

e.g.) When the base file name is “abc”, the file format is “TIFF”, and the

extension is “Use “.” ”.

File name: “abc.tif”
Output destination:

Click the “Folder...” button and designate the folder where output files

should be stored.

The server’s storage device (hard disk) should generally be designated as

the destination.  When you wish to save a file on a storage device of a

different computer on the network, first mount the other computer’s

storage device on the server computer.

Note • For the setting for the destination disk, refer to “1. Client/

server environment setup” in Chapter 2.

• Make sure not to select a folder or sub-holder of the

ColorGenius EX for the output destination.

Format:

Select the file format from among “TIFF”, “EPSF”, “JPEG”, “Scitex

CT”, and “Taiga,SPACE”.

Optional settings:

When “TIFF”, “EPSF”, “JPEG”, or “Taiga,SPACE” is selected for the

file format, the corresponding optional settings become available.

Note “TaigaSPACE” is only available when the “DotFinder” option

is selected.

For TIFF format
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Byte Order

IBM PC This box should be checked when the saved

image file is to be used with an IBM PC.

Macintosh This is the default setting in this dialog box.

Down sample

If the CMYK mode has been specified as the mode after conversion, the

Down Sample option appears.  By checking this option, the image file is

created in a low resolution so that another image database application will

be able to read the file.

Can be printed The image file is created in a resolution with

which the image can be printed.

Cannot be printed The image file is created in a comparatively low

resolution for display on any monitor.

After making your selection, clicking “OK” sets the file name and

destination.

For EPSF format

Preview

The settings concerning the data for preview are set.

Select the image format from either the PICT or TIFF for preview.

None Does not create PICT files for preview.

1 bit/pixel Creates PICT files for black and white preview.

8 bits/pixel Creates PICT files for 256-color or grayscale preview

images.
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Encoding

Select the encoding format from either the “ASCII”,  “binary” or “JPEG”.

ASCII Encodes the image data in the ASCII

format.

If you will use the saved image with

Windows, choose ASCII.  However, if

you choose ASCII, the digital dimensions

of the output file become larger.

Binary Encodes the image data in a Binary

format.

The digital dimensions of the output file

are rather compact compared with the

one encoded in ASCII.

Choose a compression setting from the

four on the left.  The lower the

compression, the better the image quality

will be. However, as the compression

rate is reduced, more disk space will be

required.

Desktop Color Separation

Desktop Color Separation (DCS) is an image format developed by Quark.

If you check this option, the image is saved into five different EPS files

(one master file and four CMYK color separation files are created in the

EPS format).

The master file contains image data in low resolution with which the

application where the file is transferred can preview the image and the

link information for the master file and the 4 CMYK color separation

files.

JPEG

(Minimum quality;

highest compression)

JPEG

(Fair quality;

better compression)

JPEG

 (Good quality;

good compression)

JPEG

(Best quality;

lowest compression)
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Master file, No composite PostScript

No image data in low resolution is contained in the master file.

Master file, 72 pixels/inch gray scale

72dpi grayscale images are contained in the master file.

Master file, 72 pixels/inch CMYK color

72-dpi CMYK images are contained in the master file.

For JPEG format

Best quality; lowest compression

Good quality; good compression

Fair quality; better compression

Minimum quality; highest compression

At this point, scanning will start as soon as the file is registered in the

server from the Server palette window.  The Prescan window reappears

and you can create setup data for another original.  The settings of the

previous original have been saved.

Therefore, it is possible to create setup data for multiple originals while

switching between the Edit window and the Prescan window; you need

not worry about saving the setup data.

Note Even when the output settings or server registration haven’t

been set, the setup data will be saved.

Recipe file copy

The recipe file will be stored in the “ColorGenius: recipe” folder, and also

can be copied to another folder.  (Two identical recipe files can be saved

in different locations.)

Choose a compression

setting from the four on the

left.  The lower the

compression, the better

the image quality will be.

However, as the

compression rate is

reduced, more disk space

will be required.
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Always save to: Click the “Folder” button and designate the

folder where the copied recipe file will be

stored.  The recipe file will always be copied to

the designated folder.

Each time, during server registration (when

clicking the “Execute”, “Scan”, and “Register”

buttons), the destination folder for the copied

recipe file can be designated.

Don’t copy The recipe file will not be copied.

1.5 Server registration
When the output settings are finished, register the settings with the server.

When you registered them with the server, the queued files containing the

setup data on the client will be sent to the server.  The server lets the FT-

S5500 start scanning when it receives the queue, and the settings of the

scanned images are executed.  The set images will be saved according to

the set file name in the destination specified under “Output”.

Let us summarize the operations performed so far.  The following are

saved as setup data and then sent to the server.

• The trimming position specified in the prescan image

• Image processing (cropping, rotation, area selection)

• Selected image type

• Selected finish

• Selected color mode

• The file output destination and file name

Batch process ON/OFF
After entering the output settings, register them with the server.  The

setup file will be sent to the server and processing will begin.  Three

methods are available for processing, i.e. “Batch process” can either be

enabled or disabled, by setting “Batch” on or off in the setup palette

window.

When the batch process is deactivated (off):

Note This operation cannot be performed in the multi-client/server

environment.

Set during setup

registration



Chapter 3  Understanding basic setup procedures

3 - 39

The “Batch” check box should always have a check placed in

it.

Clicking the “Scan” button (“Start” button for file processing) in the

Server palette window sends the setup file to the server.  When the server

receives the setup file, scanning with the FT-S5500, processing the

scanned images, and saving the results to the output destination will be

immediately started as a batch process.

The client is freed from file processing after the setup file has been

completely sent, so you can then start to create setup data on the next

original.

The server will let the next setup file stand by while it is processing the

setup file just sent (the next file is displayed in the standby list).  When

the current setup file has been completely processed, the processing of the

next setup file will begin.

In such client/server environments, setup data for the next original can be

created on the client while processing is being performed on the server.

This feature is called “background scanning” and dramatically reduces

waiting time by allowing efficient simultaneous setup preparations.

When the batch process is activated (on):

The name of the “Scan” button on the Server palette window changes to

“Register.”  Clicking this button sends the setup file to the server.  The

server does not start the processing immediately but displays the received

files sequentially on the list.

When you click the “Start” button while multiple files are standing by,

processing begins.  The files are not executed in the order the server

received them but in the order that allows the most effective scanning (the

least scanner operation) with reference to the optical conditions set for

scanning (scanning position, resolution, and magnification).

This method of first sequentially performing setup data creation for

multiple files and then executing the files in a batch is called “batch

scanning”.

Note The check-mark in the “Batch” check box remains after the

batch process is completed.
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When changing “Batch” from ON to OFF after the setup data has

been registered on the server:

Note This operation can not be performed in the multi-client/server

environment.  The “Batch” check box should always have a

check placed in it.

Check the “Batch” check box, and register the setup data in the server

management palette.  Under this condition, removing the check-mark

from the “Batch” check box starts the batch process.

The “Batch” check box remains unchecked after the batch process is

completed.

Sending the setup file
To send the setup file from the client to the server, activate the Edit

window for the original to be processed.  When the Prescan window is

displayed, click the desired original (the trimming frame color turns

green) and click the “Confirm” button.  The Edit window for the selected

image will appear.

Sending the setup file via the Setup palette window.  When the output

settings have been completed, the setup file is sent to the server and the

files are displayed on the server palette's standby list.  You can then

continue to create setup data for another original on the prescan window

or edit window.

In the Server palette window, the list of transmitted files is displayed.

When the batch process is deactivated and there is no file currently being

processed, the processing of the transmitted files will be started.

Note It is not necessary to click the “Confirm” button to register the

setup file, but is necessary to preview it.

Work example in a multi-client/server environment

By using ColorGenius in a one server/two client computers (A and B)

environment using multiple trays (A and B) as shown in the figure below,

you can perform two operations simultaneously, and efficiently utilize

one FT-S5500.

Note Before sending a prescanning or scanning command to the

server computer from client computer A as shown in the
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figure below, confirm that tray (A) has been set on the FT-

S5500 by checking in the overview image in the Server

Management palette.  Likewise, before sending a

prescanning or scanning command to the server computer

from client computer B, confirm that the tray (B) has been set

on the FT-S5500.

Client A Client B Server

FT-S5500

 

Place an original on tray (A).
Set tray (A) on the FT-S5500.

Prescan the image, setup the 
existing originals for the prescanned 
image, and register the setups on 
the server computer.

Set tray (A) on the FT-S5500.

Send the scanning command 
to the server computer.

Place an original on the tray (B).

Set tray (B) on the FT-S5500.

Prescan the image, setup the existing 
originals for the prescanned image, and 
register the setups on the server computer.

Send the scanning command to the server 
computer.

Scanning an original in 
tray (A) with the FT-S5500.

Scanning an original in 
tray (B) with the FT-S5500.

Set tray (B) on the FT-S5500.
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Operating the Server Management palette
You can check the state of queue processing on the server and view the

names of the files already sent to the server by using the Server

Management palette.  It also possible to delay the execution of queue

processing or delete files already sent to the server.

Note The overview display will automatically be updated whenever

the FT-S5500’s upper cover is opened or closed.

To delay execution of a queue:

Drag the file you want to put on-hold from the

standby list and drop it into the on-hold list.

The selected file is moved into the on-hold list

and the execution of its processing is set to on-

hold status.

To execute the processing an on-hold file,

move the file to the standby list with a drag &

drop operation as above.

Interrupts the 
processing (the 
interrupted file 
will move to the 
on-hold list.)

Clicking on this 
mark extends or 
abridges the 
information 

Shows the file 
being setup.

The list of files 
standing by

The list of 
files on hold Deletes the 

selected file.

Displays the 
current tray’s 
overview image.

Shows the time 
when the tray 
overview image 
was updated.
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To delete a queue:

Click the file you want to delete in the standby or on-hold list (the name

will be displayed in reverse video), then click the “Delete” button at the

bottom of the appropriate list.  The file will be deleted.

To interrupt processing:

Click the “Stop” button to interrupt the processing during the execution of

a setup.  The interrupted file will be moved to the on-hold list.

Note If you interrupt processing by clicking "Stop", all the scanned

image files will be moved to the on-hold list.  For opened and

registered image files, only the selected files will be moved to

the on-hold list.

About Log Window (on the server)
In the server’s Log Window, a variety of information on the processing

state of the server, setup data description, and processing start and end

times is displayed.

To hide the Log Window display:

Select “Hide Log” from the Preference menu.  When the Log Window

display is deactivated, select “Show Log” from the Preference menu if

you want the Low Window to appear.

To delete the log file:

Select “Clear Log” from the Preference menu.
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Quitting ColorGenius
When quitting the application, first quit the client and then the server.

Turn the power to the computers and the FT-S5500 OFF in the reverse

order of launching (i.e. turn off the client first, then the server, and the

scanner last).
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2. Settings for using ColorGenius in a standalone

environment
Using only the client application of ColorGenius, you can import and

process image files.

Note • In the standalone environment, actual images other than

coarse images are displayed on the monitor and processed.

• You cannot import image data from the scanner and perform

batch processing in this environment.

2.1 Booting the computer
1) Turn the power to the computer ON.

2) Launch ColorGenius.

After the initial screen is displayed, the screen for the standalone

environment appears.

Note When a dialog box for selecting a server appears, click

“Cancel”.
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About the screen configuration
The following areas of the standalone environment have different screen

configuration than the client/server environment.  The other parts are the

same as in the client/server environment.

Note For the screen configuration in the client/server environment,

refer to “Configuration of ColorGenius screens” in the “1.1

Starting the program” section.

Setup palette (Easy setup palette):

After selecting the setup commands (image type, finish, and color mode)

and choosing “Save as...” from the “File” menu, the setup processing is

executed at the full image resolution.

No parameters for resolution or magnification are displayed.

The Information palette, Profile palette  is the same as in the client/server

environment.

Note There is no Server Management palette window in the

standalone environment.
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2.2 Openning an image file
This section explains how to import images into ColorGenius in the

standalone environment.

1) Select “Open” from the “File” menu, or click the “File input” button

in the setup palette window.

2) Select the file and click the “Open” button.
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2.3 Starting Easy Setup
The operation above imports images into ColorGenius, but differs from

similar operations in the client/server environment in that the actual full

resolution images are displayed.  That is, in the standalone environment,

the setup commands are executed directly on the full resolution images.

Selecting the type of input original
From the menu, choose the type of input image to select the original type

in the setup palette window.  The items in the Setup palette window’s

“Image” menu differ depending on the original type.

The original types are:

Transparency

Reflection

Printed matter

Negative

Water color

Others

To select the type of input original:

Choose the desired original type from the “Original” menu in the setup

palette window.

Processing the image
If image processing is required, after the image is prepared (selected,

cropped, etc.), use the various tools in the tool box to modify the image.

Note Use of all the tools is explained in “Image processing with

tools” in the “1.4 Setup essentials” section.

Selecting the image type, finish, and color mode
Choose the image type, finish, and color mode for output.

Note that the items in the “Image” menu differ depending on the type of

original selected in the setup palette window.

Note For more details on: image selection, see “Selecting the

image type”; finish selection, see “Selecting the finish”; and

the output image mode, see “Selecting the output image

mode” in Section “1.4 Setup essentials”.
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Saving the image
Save the setup image.

To save the image:

1) Choose “Save as...” from the “File” menu.

2) Designate the destination disk or folder.

3) Enter the file name.

4) Choose the format of the image file from the “Format” menu.

Supported formats include “TIFF”, “EPSF”, “JPEG” and

“ScitexCT”.

5) Choose “Continue editing after saving file” or “Close document after

saving file”.

After the setup and file save are executed, the

image affected by the setup is displayed in the

edit window.

After the setup and file save are executed, the

edit window is closed.

6) Click “Save”.

When you select a file format other than “ScitexCT”, a format-specific

dialog box is displayed.  After entering the desired setting(s), click

“Save”.

Note For details on the Save dialog box for each format, refer to

“Setting file output” in section “1.4 Setup essentials”.

Continue editing

after saving file

Close document

after saving file
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3. Fine adjustment with Easy Setup
Clicking the button shown below (called the “Easy setup: Fine

adjustment” button hereafter) on the Setup palette, or choosing “Easy

setup: Fine adjustment” from the “Image” menu, opens the “Easy Setup:

Fine Adjustment” dialog box in which you can make more precise

settings for color correction and sharpness.

3.1 Opening the “Easy Setup: Fine Adjustment” dialog box
When the Image window (Edit window) is open, clicking the “Easy setup:

Fine adjustment” button on the Setup palette opens the “Easy Setup: Fine

Adjustment” dialog box.

Shows or hides
the preview
image.

Enter settings in
the “Easy Setup:
Fine Adjustment”
dialog box and then
close it.

Sets all the settings
to neutral.

Sets the setting to neutral.

Linked with the buttons for line-up display
and for overlap display in the edit window.

Enlarges/reduces,
scrolls or samples
an image.
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3.2 Adjusting the overall contrast and lightness
The contrast (weak or strong) and lightness (dark or light) across the

whole image can be adjusted with these sliders.

To adjust the contrast:

Moving the slider to the right raises the contrast level, and moving it to

the left lowers the contrast.

To adjust the lightness:

Moving the slider to the right lightens the image, and moving it to the left

darkens it.

When adjustment is completed, click “Apply”.

3.3 Correcting colors
Correcting areas containing flesh tones, blue sky, or greens

Portraits or landscapes are occasionally used in input originals.  When an

original contains such images, the hues of a portrait’s flesh tones or the

sky’s blue or landscape greens are important factors in the finish.

Using the sliders for flesh tone, blue sky or green allows you to brighten

or darken only the areas containing such hues, while scarcely affecting

areas containing other hues.

Moving these sliders to the left only dims the areas containing these hues,

while moving them to the right brightens only these areas.
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Correcting each hue

Choose a hue you want to correct from the color wheel in the dialog box,

and you can correct the area containing this hue using the saturation, hue

and/or lightness sliders.

Clicking the hue you want to change in the color wheel displays a round

mark.  When you operate the saturation, hue and/or lightness sliders, only

the selected hue will be changed.

To adjust saturation:

Moving the slider to the left increases the amount of complementary color

in the selected color (the color opposite to it in the color wheel) and thus

dims the selected color.  When you move the slider to the right, it

decreases the admixture of complementary color and thus brightens the

selected color.

When moving the “Flesh” slider to
the right (Bright).

Click the hue you 
want to adjust in the 
color wheel at left.

Adjust the selected hue 
with the respective sliders. 
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To adjust hue:

Moving the slider to the left brings the selected color closer to the next

hue in the color wheel in the clockwise direction.  Moving it to the right

brings the selected color closer to the next hue in the color wheel in the

counterclockwise direction.

For example, if you choose red from the color wheel and move the slider

to the left, the red hue in the image is gradually replaced with magenta.

Conversely, if you move it to the right, the red hue is gradually replaced

with yellow.

When moving the “Saturation” slider to
the right (Increase) for the selected red
hue (on the color wheel).

When moving the “Hue” slider to the right
(toward the yellow) for the selected red
hue (on the color wheel).
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To adjust lightness:

Moving the slider to the right increases the R, G, and B tone curves in

areas containing the selected color.  Moving it to the left decreases the R,

G, and B tone curves in these same areas.

When moving the “Lightness”
slider to the right (Increase) for the
color selected red hue (on the
color wheel).
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When moving the “Priority
(Gray <-> Color)” slider to the
left (Gray).

When moving the “Priority
(Gray <-> Color)” slider to the
right (Color).

Reducing the influence of color correction on gray areas
If a color is changed to another with the color correction commands, gray

areas in the image may be muddled or otherwise affected and

consequently distort the gray axis.  To prevent this impurity problem,

move the “Priority (Gray <-> Color)” slider to the left (Gray), and grayish

areas (where the R, G, and B tone curves are similar) will be replaced

with true gray.  Note, however, that this replacement reduces the

saturation level, and thus can add an gray cast to the pale colors in the

image.

If you move the slider to the right (Color), it will inevitably distort the

gray axis, but it will also increase the saturation of grayish parts, which

will allow a brighter overall finish.
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When moving the
“Atmosphere (Cold <->
Warm)” slider to the left
(Cold).

When moving the
“Atmosphere (Cold <->
Warm)” slider to the right
(Warm).

Changing the overall tone to a colder/warmer feeling
Images that contain mainly reddish hues look warm, while those that

mainly contain bluish hues look cold. The “Atmosphere (Cold<->Warm)”

slider allows you to correct the overall tone to a colder or warmer color.

When correcting an RGB image, moving the slider to the right (Warm)

increases the R tone curve and reduces the G tone curve.  Conversely,

moving it to the left (Cold), reduces the R tone curve and increases the G

tone curve.

When correcting a CMYK image, moving the slider to the right (Warm)

increases the M density and reduces the densities of C and Y.

Conversely, moving it to the left (Cold), increases the C and Y densities

and reduces the M density.
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3.4 Adjusting sharpness
You can adjust the sharpness in the “Easy Setup: Fine Adjustment” dialog

box.  Sharpness refers to the effect that increases image intensity by

increasing the contrast level of adjacent pixels.

Setup dialog box for the “Fine adjust sharpness”
Click the “Sharpness” tab in the “Easy setup: Fine adjustment” dialog,

and the sharpness fine adjustment section will be displayed.

Note These simulation windows do not appear if you connect the

scanner in a client/server environment.  These simulation

windows will appear when a file is opened, however they will

disappear if you crop or rotate the image or change the

display size.

Sharpness can be adjusted using the following sliders: “Weak <->

Strong”, “Rough <-> Smooth “ and “Delicate <-> Accented”.

After sharpness correction, the simulation window displays the simulation

images, which sample the upper left corner, center, and lower right corner

of the image.  The display sizes of these simulation images and/or the

regions displayed can also be changed.

Switches whether or
not to display the
preview image.

Sets the setting to neutral.

Linked with the buttons for line-up display and for
overlap display in the edit window.

Sets all the slider
settings to neutral.

When “Display preview image
in Sharpness fine adjustment
section” is checked in the
“Preferences: Setup environ-
ment” dialog,  these simulation
windows are displayed.



ColorGenius EX USERS MANUAL

3 - 58

To change the display size:

Choose the desired size from X1, X2 or X4.  The image display size in

the simulation window will be changed to the selected size.

To change the display region:

Clicking the “Auto Extract” button extracts the most contrasty area

(which has the greatest effect on sharpness), an intermediate area, and the

least contrasty area, and displays them in order from the left.

You can also display any area you wish in the image.  Selecting the color

picker tool and placing the cursor in the Image window holding the

control key changes the cursor shape to .  If you now move the cursor

to a position you want to display and click on it, the selected area will

appear in the simulation window.

Sharpness adjustment commands
Sharpness can be adjusted with the three parameters: Strength (weak/

strong), Graininess (rough/smooth), and Mask size (delicate/accented).

When the sharpness setup area appears, the standard (intermediate) values

for each parameter are displayed.

To adjust the strength:

Move the “Weak <-> Strong” slider in either direction to set the strength

of sharpness. There are 10 steps in either direction from the standard

(center) point.

To adjust the graininess:

Applying sharpness may roughen the image.  The higher the contrast

level, the more the graininess will be generated.  If the strength of

sharpness is substantially increased, even the least contrasty areas may

become rough.

Moving the “Rough <-> Smooth” slider to the right (Smooth) helps keep

the image smooth (by not applying sharpness to the less-contrasty areas).

However, the more this slider is moved to the right (Smooth), the more

sharpness will be weakened.

To adjust the mask size:

Moving the “Delicate <-> Accented” slider to the right (Accented)

enlarges the mask size, while moving it to the left (Delicate) reduces the

mask size.  When the mask size is enlarged, the contrast is emphasized

along outlines over a wider area.  Conversely, making the mask size
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smaller narrows the area in which sharpness is applied to outlines.

When a large mask size is set for a low resolution image, wide edges or

borders appear along the image’s outlines.  Even if you weaken the

strength of sharpness, it will still look as if strong sharpness has been

applied.

If a small mask size is set for a high resolution image, sharpness has

hardly effect on the image even when you strengthen the sharpness.  Set a

mask size that is appropriate to each image’s resolution or magnification.

3.5 Enlarging/reducing, scrolling and color picking

Enlarging and reducing

You can use this tool in the same manner as for the Magnifying glass tool

in the tool palette.

Please refer to “Processing images with tools” of “1.4 Setup essentials” in

Chapter 3.

Scrolling

If the Magnifying glass tool is used while you are holding down the

command key, the cursor will change to a hand shape. Dragging an image

with this cursor allows you to scroll the image.

Color picking

You can use this tool in the same manner as for the Color picker tool in

the tool palette.

Please refer to “Processing images with tools” of “1.4 Setup essentials” in

Chapter 3.

 Magnifying glass tool

Color picker tool
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4.  Manual Fine Adjustment
You can use Easy Setup simply by selecting keywords for the image’s

mode, type and finish.

However, depending upon the type of setup, subtler adjustments may be

necessary.  Manual fine adjustment allows you to perform more precise

image settings and individually determine the commands to be used and

the values for each parameter.

Clicking the button shown left on the Setup palette or choosing “Manual

Setup :Fine adjustment” from the “Image” menu opens the “Manual fine

adjustment” dialog.  Perform the settings described below, and click the

“OK” button after they are completed.

These values are red if they are 
automatically detected by the Easy 
setup function (initial values), but 
change to black if modified. 

Sets the highlight/shadow 
points

Sets the maximum/minimum 
dot percentages

Linked with the 
buttons for line-up 
display and for 
overlap display in 
the edit window.

Opens the “Custom 
keyword editing” dialog.  
(Refer to “1.1 Keyword 
customization” in 
Chapter 4.)

Overwrites a saved 
output profile. (Refer to 
“1.2 Profile 
customization” in 
Chapter 4.)

Returns all the settings 
to their default values.Enlarges/reduces, 

scrolls or samples 
an image.
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4.1 Color correction and tone curve (Retouch color, Misc. )
The color correction dialog box allows you to select a color from the

image, change it to another color, or adjust its saturation.  The “Retouch

color” tab is used for changing the contrast or brightness of particular

images.  For RGB or CMYK images, you can also change the hue by

adjusting the tone curve for each color channel.

When an RGB input image is set to CMYK as the output mode, tone

curve and color correction is possible in both the RGB and CMYK

modes.

When an RGB input image is set to Grayscale as the output mode, tone

curve and color correction is possible in both the RGB and Grayscale

modes.

When the input image is in the CMYK or Grayscale mode, tone curve is

only possible in their native modes.

Tone correction section

Adjusts the color correction settings.

Adjusts the tone curve.

Color correction section
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Tone curve
The following tone curve is displayed in the tone correction section.

The X axis represents the input level and the Y axis represents the output

level after the tone level is corrected.  The displayed curve illustrates the

relationship between the input and output values.

Enlarge

Input each value for the highlight, 
midtone, and shadow points.

Select a color channel 
(RGB, R, G, B).

Highlight

RGB=0
Shadow

RGB=255

Midtone

In the RGB mode, the leftmost end of the tone curve shows the shadow

area (tone level 0 = black) and the rightmost end shows the highlight area

(tone level 255 = white).  The graph is divided into 50 tone units.

You can select the RGB combined channel or one of the R, G, or B

channels.  The RGB channel corrects the tone of each channel the same
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amount, and the R, G and B channels correct only the tone of selected

channel.  When the tone curve is again corrected in an individual channel

after it has been corrected in the RGB channel, the two tone curves are

combined.

In the CMYK mode, the tone curve can be corrected in the -50 to 150%

dot.  The graph is divided into increments of a 40% dot percentage.  You

can select the C, M, Y, K or CMY channel.

Enlarge

Input each value for the highlight, 
midtone, and shadow points.

Select a color channel 
(CMY, C, M, Y, K).

Highlight

-50%

Shadow

150%

Midtone
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To correct the tone level:

1) Choose the channel (or all channels) you want to adjust from the

channel menu.

2) Set a value in the “Highlight”, “Midtone”, and “Shadow” fields.

3) If you want to modify the tone curve using the mouse, click the

“Enlarge” button.

Arbitrary Modifies any points you wish.

Highlight Modifies only highlight values (indicated by the “ ”

mark).

Midtone Modifies only midtone values (indicated by the “ ”

mark).

Shadow Modifies only shadow values (indicated by the “ ”

mark).

Place the cursor at any point along the curve, or over a “ ”, “ ”, or

“ ” mark, and click.

The graph curves so that the line will pass through the selected point.

The dot on the line will remain at the position you clicked.  Even

when you add a new dot, the previous dot will remain visible.

If you want to move a dot you have already set, place the cursor on

the dot and drag it in the desired direction.  (You can remove the

selected dot entirely by dragging the cursor outside the graph.)

Note After saving the set tone curve with the “Save” button in the

“Tone Curve” dialog box, you can apply the values of the set

tone curve to other originals with the “Apply” button in the

“Tone Curve” dialog box.

Correcting colors
When the output mode is set to RGB or CMYK, you can correct the

colors in their native mode.

Changing in the RGB mode

You can adjust the hue strength, saturation and luminance for a selected

image hue (cyan, magenta, yellow, red, green or blue) or adjust the

saturation of the entire image.  There are two ways to correct the

saturation of an image: either by moving the slider to change the
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saturation level for the entire image (including both highly and less

saturated areas), or by correcting saturation with reference to the purity of

the gray axis.

To correct the selected hue parameters

You can individually correct the hue strength (H), saturation (S) and

luminance (L) of 6 different hues (Color wheel: magenta, red, yellow,

green, cyan and blue).

Hues (Color wheel)

Hue strength

Saturation

Luminance

Loads the settings
stored in a file.

Saves the settings
to a file.

If you set the parameters as above, the yellow hue in the image will be

corrected accordingly.

The hue color wheel is arranged in the following order: magenta, red,

yellow, green, cyan and blue. Therefore, if the yellow hue is set as above

and a positive value is entered in the hue strength field, the hue changes to

greenish (moves in the green direction).  Entering a negative (-) value in

the hue strength field moves the yellow hue in the red direction.  In

addition, entering a positive value (+) in the saturation field intensifies the

corresponding hue color, and entering a positive value (+) in the

luminance field makes the corresponding hue color brighter.

Note After the “Select” button is activated, clicking an arbitrary point

in the edit window with the color picker tool while holding

down the command key will automatically record the hue

information at that point.
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To correct saturation:
In the “Misc.” tab section, an image’s saturation can be adjusted using the

saturation slider.  Moving the slider to the right increases the value in the

box (max. 100) and raises the saturation of the entire image.  Moving it to

the left changes the setting to a negative value (min. -100) and reduces the

saturation of the entire image.

To adjust saturation with the gray axis purity command:
In the “Misc.” tab section, you can input values in the “Gray axis purity”

field to correct saturation in the gray area.  This command lets you adjust

the correction area and level ranging from low (-100) to high (100)

saturation levels.  The default value is 0.

Inputting a positive number lowers the saturation level.  The higher the

value,the wider the correction area and the larger the correction volume.

The smaller the value, the narrower the correction area the narrower the

correction area and smaller the correction volume.

Using the saturation slider will allow you to adjust the entire image,

ranging from highly saturated areas to less saturated areas, to the same

saturation level.  The gray axis purity command is used to adjust only the

gray areas.  A positive value compensates for changes induced by the

slider so that the end result will be little or no color change in the gray

areas.  If you enter a positive number in the field next to the saturation

slider, you can increase the saturation of the entire image.
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Corrects the density
of each separation
(-100 to 100).

Change in the CMYK mode
You can change the tone by adjusting the density for each separation (C,

M, Y and K).

To correct the tone by the hue:

Adjust the densities of C, M, Y and K separations individually (cyan,

magenta, and yellow - and the first triad’s complementary colors - red,

green, blue).

For example, the above settings show that the dot density for the yellow

hue is low in the C, M and K separations, and is high in the Y separation

(nearly the pure color).

Note After the “Select” button is activated, clicking an arbitrary point

in the edit window with the color picker tool while holding

down the command key will automatically record the hue

information at that point.

Hue (Color wheel)

Color Separations

Hue (Color wheel)
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4.2 Sharpness settings (Sharpness)
The sharpen and unsharpen commands are respectively used to bring out

detail in blurred images and soften the finish of an image.

To adjust sharpness or unsharpness levels, click the “Sharpness” tab.

“Sharpeness” enhances image sharpness, making contrasty areas appear

even more contrasty.

“Unsharpeness” softens the borders between obviously different color

areas by narrowing the tonal gap between the pixels at the color

boundaries.

Setting gain and highlight/shadow

Adjusts sharpness level.

Set the strength of
sharpness to be
applied to the
highlight and shadow
areas relative to the
gain value: from -100
to 100%.

Set the strength of sharpness to be
applied to the entire image, ranging from
0 to 100.
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Gain refers to the overall sharpness strength.  For the highlight and

shadow settings, set the percentages at the highlight and shadow points to

the gain value (for the entire image).

If the same strength sharpness that is applied to the midtone is also

applied to shadow or highlight areas, the dot density may appear entirely

solid or dots may disappear, either of which will degrade the image

smoothness.  To prevent this problem, the strength of sharpness applied to

highlight and shadow areas should be less than that applied to midtones.

The highlight and shadow percentages can be set from -100 to 100%.

0

10

20

 Highlight Midtone Shadow

Strong

Sharpen

In this curve where the gain
is set to 20, the highlight to
40% and the shadow to
60%, the sharpness for the
midtone is 20, for the
highlight, 8 and for the
shadow, 12.

0

10

20

-20

-10

Highlight Midtone Shadow

Strong

Sharpen

In this curve the gain is set
to 20, the highlight to 0%
and the shadow to -50%.
The sharpness strength in
the shadow area is sup-
posed to curve in the minus
direction (broken lines), but
all minus values actually
become 0 (no sharpness is
applied).
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Setting mask size
The sharpness function detects contrasty areas in the image, and darkens

dark (blackish) pixels and conversely lightens lighter (whitish) pixels to

further emphasize the contrast.

The size of the border mask designates the number of pixels affected by

sharpness functions outside an image outline.  When the mask size is set

to a large value, a wide area around an outline becomes sharp; and when

it is set to a low value, only the outline itself will be sharp.

If a large mask size is set for a low resolution image, thick edges will

appear along the image outlines, and the sharpness level will also look

strong even though its strength is set to weak.

On the other hand, if you set a small mask size for a high resolution

image, the sharpness function will not be effective even if a strong level is

set.  Set the appropriate mask size according to the image’s resolution or

magnification.

Setting graininess

When you set a high gain value, outlines will be emphasized even in less

contrasty areas, and graininess will consequently appear on the image.

Set a high graininess value when you do not wish to apply the sharpness

function to low contrast areas.

When the gain value is fixed, the relation between an image’s contrast

and sharpness levels is shown below.  Setting a high graininess value

widens the area where sharpness is not performed.  Setting it to low

widens the area where sharpness will be performed.

The higher the graininess value, the less
rough the image, but high values will also
correspondingly reduce the general
effect of the sharpness function. (Range:
0 to 10)
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Setting outlines
Performing sharpness emphasizes image outlines, i.e., black and white

borders appear in contrasty areas.  Sometimes, however, depending on the

image, it is better that either white or black borders do not appear.  You

can therefore now adjust the contrast settings for black and white borders

individually to prevent either or both from appearing.

The lower the value (%) in the “Black” field, the more unlikely it is a

black border will appear.  In the same manner, the lower the value in the

“White” field, the more unlikely it is any white borders will appear.

Although the white value is usually set lower than the black, in cases such

as human facial outlines, no black borders should appear.  In this case, the

white value should be highwer than the black.

The following graph illustrates the relationship between the gain level in

the sharpness function, the black/white setup value (%) and the mask size.

Strong
Sharpness

Sharpness

High Contrast
0

Graininess setup value 

When graininess is set.

When graininess
 is not set (=0).

If you increase either of these values, the edge
of the increased color will become narrower.

dark

light

a

a

c

b

b

d

a: Gain (strength of sharp-
ness)

b: Mask (number of pixels to
be affected)

c: White (degree of white
sharpness strength
corresponding to the gain
level.)

d: Black (degree of black
sharpness strength
corresponding to the gain
level.)
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Applying sharpness to flesh colors
When the entire image is sharpened, human flesh may appear rough with

black pimples.  To reduce such an effect, the sharpening can be softened

using the following function.

1) Check the “Apply to flesh tones” check box.

2) Set the “Level” and “Smoothness” fields.

Level Reduce the sharpness strength for flesh colors.

(Compared with the “Custom Sharpness” function

described below, this function’s processing speed is fast.)

Smoothness Moderate the tone curve for the fresh colors to soften the

finish of human skin areas.

Sharpen/Unsharpen selected colors
The “Custom Sharpness” command specifies certain colors in the image

that sharpness should be applied to and adjusts the strength of the

sharpness for these tone areas.

To use the “Custom Sharpness” function:

Check the “Custom Sharpness” option in the “Sharpness” dialog box.

1) Select the color specification method (RGB or HSL color space)

from the color model menu.

2) Click the “Selected ...” button.  Placing the cursor inside the image

changes the shape of the cursor to the color picker.  Place the cursor

on the color you want to select in the image and click on it with

holding down the command key.

The selected color is displayed in the “Selected color” box.

The values for the selected color are displayed in the boxes of the R,

Select the color
space.

Select the effective tone area
to be sharpened based on
the specified color.

Set the sharpness
strength to be applied
to the selected color:
from 0 to 200%.
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G and B (H, S and L).  You can change the selected color by clicking

the “ ” or “ ” button or directly inputting the values.

3) Select the effective color sharpening area from the “Effective area”

menu.

There are five choices for effective area (from “Extra Wide” to

“Extra Narrow”), and after one is selected its corresponding color

space value is displayed on the right.  This value represents a

diameter in the L*a*b* color space.  Sharpness is performed on all

tones covered in the space (sphere) defined by this diameter with the

specified color at its center.

Note A setting of 100 represents the diameter of a space with the

selected color at its center, which in turn defines the effective

area of the sharpness function within the total L*a*b* color

space.

4) Set the gain level (%).

This value is a percentage of the overall gain level.  Therefore, when

the overall gain level has been set to 50 and you set 50 (%) for the

selected color’s gain level, an absolute gain level of 25 will be

applied to the selected color area.

Adjusting the unsharpness
With the unsharpness adjustment commands, you can adjust the gain level

and mask size.
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4.3 AI Setup (AI Trim)
AI Setup refers to features for analyzing the density distribution of the

entire image and setting satisfactory highlight and shadow points.  It also

analyzes common color components in the highlight and shadow areas

and adjusts the color balance of the entire image by decreasing these

components.

Description of AI Setup
Auto setting the highlight and shadow points

Depending on the input original, the shadow area may become too dark

and consequently obscure the boundaries in the background, or dots may

disappear in highlight areas and diminish the solidity of the image.  AI

Setup automatically sets appropriate highlight and shadow points on such

originals and corrects the tone distribution across the whole image.

AI Setup designates appropriate highlight and shadow points after

analyzing the entire image’s density distribution, even on originals which

contain very small or widely dispersed highlight and shadow areas.

Clicking the “AI Trim” tab displays the fine adjustment section for AI

Setup.
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Setting the area for AI analysis
With the AI setup, the area selected with the AI tool on the tool palette is

analyzed. The AI analysis area will be displayed in the red frame. If you

don’t select an area, the area for AI analysis is automatically chosen as

follows: the width and height of the chosen area is 70% of the image’s

width and height, calculated from the center of the image. If the edge of

the mask sheet is scanned into the image, select only the area of the

original.

To change the tone level of a highlight, shadow or midtone:

Moving the highlight slider to the right lowers its tone level and the

highlight area becomes brighter.  Moving it to the left raises the tone level

and the highlight area becomes darker.

Moving the shadow slider to the right lowers its tone level and the

shadow area becomes brighter.  Moving it to the left raises the tone level

and the shadow area becomes darker.

Moving the midtone slider to the right lowers the midtone curve and the

midtone becomes darker.  Moving it to the left, raises the tone curve and

the midtone becomes brighter.

To change the strength of Highlight Cast/Shadow Cast

Highlight Cast/Shadow Cast detects common color components in

highlight and shadow area, and attempts to adjust the color balance by

removing such components.

Adjusts AI Setup.

AI tool
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4.4 Settings for mode conversion (HD, SD, MAX, MIN, ICR, Mixing ratio)
You can set the density of highlight points (minimum density) and

shadow points (maximum density) when converting RGB images to

CMYK images.  When the mode is converted to CMYK, a K separation

will be created.  It is also possible to set the start point (tonal value) for

the K separation.

When setting up an RGB image in RGB mode, the tonal values for each

color’s shadow and highlight points can be changed.  When converting to

Grayscale, you can also set the lightness percentages for R, G and B.

Converting to CMYK
The RGB to CMYK conversion separates the image into C, M, Y and K

separations via a selected mode conversion calibration profile.

Although gray (black) areas are supposed to be created with the C, M and

Y separations, it is difficult to create pure grays with the same density as

the other separations for actual printing, so a K separation is also created.

Setting the dot percentage of highlight/shadow points

When creating C, M, Y and K separations from a CMYK image and

printing them, it may be advisable to change the dot percentages of the

highlight/shadow points depending on the type of ink or paper.  The K

separation’s entry point (along the image’s highlight to shadow axis) will

significantly affect the quality of the final result.

In the “Max/Min...” area, you can set the dot percentages for highlight

and shadow and the start point of the K separation (K-shift) for each

CMYK separation. You can also access and operate the ICR function and

the UCR/UCA function in the “ICR” tab section.
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Setting highlight/shadow points

In ColorGenius, the highlight and shadow points are automatically

determined with the AI Setup function.  However, if you want to set them

manually, follow the procedures below.

Note • The highlight and shadow points can not be set when the

original type is negative film.

• Changing the “HD” or “SD” value will remove the check mark

from the “Use AI setup” checkbox in the “AI Trim” tab.

1) Select the “HD” button in the “Manual fine adjustment” dialog.

Then, while pressing down the command key, click a point you wish

to set as the highlight point in the edit window, or enter a value for

that point in the dialog.

2) Select the “SD” button in the “Manual fine adjustment” dialog.

Then, while pressing down the command key, click a point you wish

to set as the shadow point in the edit window, or enter a value for that

point in the dialog.

Adjust ICR
Adjust
UCR/UCA
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Maximum/Minimum dot percentage setting

This setting designates the dot percentage of the highlight and shadow

points of the image.  In the ColorGenius, the highlight and shadow point

setup is performed at the RGB level with the AI Setup function, highlight

and shadow point setup is performed in the RGB mode with the AI Setup

function or by manually changing their densities.  The Max/Min setting

sets the dot percentage of the highlight and shadow points on the setup

RGB image.

The ColorGenius internally has a standard value for the highlight and

shadow points at the RGB level.  The AI Setup sets the tone level of the

highlight points as 245 and that of the shadow points as 20 according to

the standard value.  So, the Max/Min setting sets the dot percentage for

the 245 RGB tone level and that for the 20 RGB tone level.

K-Shift setting

Input a RGB value in the "K-Shift" field from 0 to 255 to set the starting

point of the K separation.  When the value is increased, dots begin

appearing in the K separation from the light area.  When the value is

decreased, dots start appearing in the K separation from the dark area.

The following graph illustrates the relationship between the minimum dot

percentage, the maximum dot percentage and the K-Shift setting.
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UCR/UCA setting

This setting adjusts the tone curve of the gray component of the image.

You can designate a starting point of the UCR/UCA effect with an RGB

level from 0 to 255 and an UCR/UCA value for each C, M and Y

separation with a value from -100 to 100.  Minus value settings reduce the

gray component in each separation and a -100 setting makes the tone

curve of the gray component flat.

ICR setting

Mixing equal amounts of cyan, magenta and yellow ink theoretically

creates gray.  For example, when the CMY ratio is as shown in the

following figure, the gray component corresponds to Y (the smallest color

component) and equal amounts of the other two colors.  In other words, if

the same amounts of color are removed from pixels which include C, M

and Y components, and this tertiary color is then replaced with gray (K

separation), the overall tonal value will not change.

The ICR function replaces dark tertiary colors (consisting of C, M and Y

mixtures whose individual dot percentages are all greater than 0%) with

UCR

UCA
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the K separation and automatically performs color correction so that the

resulting color approximates the replaced color. The ICR setting ranges is

from 0 to 100.

When ICR is set to 100, the tertiary color is always replaced with K and

the remaining fractions of the other two colors.  If ICR is set to 0, this

replacement is not performed.

The ICR setting allows you to reduce the total amount of ink used, and

shortens the ink drying time.  Also, when the density differs between the

three ink colors, it reduces hue inconsistencies and improves the

appearance of the gray tones.  Note, however, moire is likely to occur

during printing if the K separation is included to create a color which can

actually be reproduced with only the C, M and Y colors (i.e., a fourth

separation increases the chance of moire interference).
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Set the Shadow Set the High light

Converting to RGB
You can change the individual R, G and B highlight and shadow values

for RGB conversion.

To set highlight/shadow points

Set highlight/shadow points using the same procedure noted in

“Converting to CMYK”.

To change the max/min tonal value:

Input values in the fields.  Checking the “Preview” option previews the

image with the currently set conversion values.



ColorGenius EX USERS MANUAL

3 - 82

Converting to Grayscale
When the color mode is converted from RGB to Grayscale, the grayscale

tonal value is calculated from the R, G and B tonal values for each pixel

and the mixing ratio currently set in the “Mixing ratio” tab section.  In

this section, you can change the mixing ratio and contrast level, and set

the dot density values for highlight and shadow points.

Set the dot percentages for highlight 
and shadow points.

Set the mixing ratio.
Set the contrast 
level from -10 to 10.

To set highlight/shadow points

Set highlight/shadow points using the same procedure noted in

“Converting to CMYK”.

To set the maximum and minimum grayscale values:

Set the dot percentages for the highlight and shadow points on the K

separation.  Enter the values in the “Min” and “Max” fields.

To change the mixing ratio:

Enter the values of the new mixing ratio in each of the R, G and B fields

from the range of 0 to 100.

To adjust the contrast:

You can adjust an image’s contrast level by changing the value in the

“Contrast” field (in the range from -10 to 10).  The higher the value, the

higher the contrast.
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4.5 Enlarging/reducing, scrolling and color picking

Enlarging and reducing

You can use this tool in the same manner as for the Magnifying glass tool

in the tool palette.

Please refer to “Processing images with tools” of “1.4 Setup essentials” in

Chapter 3.

Scrolling

If the Magnifying glass tool is used while you are holding down the

command key, the cursor will change to a hand shape. Dragging an image

with this cursor allows you to scroll the image.

Color picking

You can use this tool in the same manner as for the Color picker tool in

the tool palette.

Please refer to “Processing images with tools” of “1.4 Setup essentials” in

Chapter 3.

 Magnifying glass tool

Color picker tool
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5. Precautions when changing the setup parameters
If you modify the parameters detected by Easy setup (Intelligent setup)

via the “Manual fine adjustment” function and implement the operations

described below, a warning will appear.

• When changing the image keywords.

• When changing the original type.

• When fine adjusting using the “Easy setup: Fine adjustment” function.

Clicking the “OK” button clears the parameters that were modified via the

“Manual fine adjustment” function and sets the redetected parameters.
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If you modify the parameters detected by Easy setup (Intelligent setup)

via the “Manual fine adjustment” function and implement the operations

described below, a warning will appear.

• When changing the resolution.

• When changing the magnification.

Button Function

Cancel Cancels the operation.

Not clear Uses the parameters that were modified via the “Manual

fine adjustment” function as they are.

Clear Clears the parameters that were modified via the “Manual

fine adjustment” function, and sets the redetected parameters.

Clear Only clears the parameters for sharpness that were modified

sharpness via the “Manual fine adjustment” function, and sets the

only redetected parameters for sharpness.

End of  Chapter 3
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Chapter 4 Utilizing convenient functions

This chapter explains the useful functions which enhance the efficiency of

the setup process.

1. Customizing
The various customizing functions are described below.

1.1 Keyword customization
The settings in the “Manual setup” dialog can be registered as a keyword

for Easy Setup.  You can select the registered keyword in the “Image”,

“Image (detail)”, and “Finish (options)” fields in the Setup palette

window.  To register manual fine adjustment settings, follow the

procedure below.

1) Click the button shown in the Setup palette figure below, or choose

“Manual Setup : Fine Adjustment” from the “Image” menu.

2) After all of the settings are completed in the “Manual fine

adjustment” dialog, click the “Customize” button.
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3) Select your intended item in the “Keyword to be customized” pop-up

menu, and enter a keyword name in the “New keyword name” box.

Then click the “Customize now” button.

4) Perform finish keyword customization as for step 3).

5) Click the “End” button.

Note Click the “Reset This Keyword” button to return all the

parameters for the selected keyword to their default values.

1.2 Profile customization
You can load the stored output profile in the dialog and modify the

contents.
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Modifying the contents of an output profile

1) When you click the “Modify Output Profile” button in the Manual

fine adjustment dialog box, the “MIN/MAX fine adjust...” dialog box

will appear, as shown below.

2) Set the MIN and MAX values and click “OK”.

3) Select the file to be modified and click “Open”.



ColorGenius EX USERS MANUAL

4 - 4

1.3 Editing image handling parameter preferences
With this setup parameter editing tool, the degree of applied sharpness is

adjusted individually for each CMYK separation, and the ICR settings are

changed.

1) From the “File” menu, choose the “Setup environment” sub-menu

under “Preferences”.

2) Click the “Image handling preference” button.  The “Environment

parameter editing” dialog will appear.

ICR settings
ICR start (Default: 5, 0 to 100)

This sets how far from the Cyan separation’s minimum halftone dot value,

as set in the CMYK Max/Min settings, ICR processing starts. If you set the

ICR to 100%, which is where the K separation begins, the C, M, and Y

separations will be left as is. If the C separation’s minimum halftone dot is

4%, and the ICR lower threshold is 5%, then ICR starts at 4+5=9%.

ICR limit (Default: 50, 0 to 100)

This sets the value at which the C, M and Y separations are used for ICR.

The higher the threshold, the further the C, M,. and Y separations ICR

threshold will be towards the shadow values.
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UCA (Default: 0, -100 to 100)

This sets the increase of the C, M, and Y separations from the upper ICR

threshold. When this is set to 0 and the ICR is 100%, the C, M, and Y

separation values are not increased, and remain as is. When this is set to

100 and ICR is at 0% (ICR off), the values increase to match the C, M,

and Y separation curves.

Sharpness settings
Sharpness gain settings for each separation (CMYK) (0 to 255)

This sets the level of sharpness for the C, M, Y, and K separations. When

this is set to 0, there will be no sharpness applied to that separation. When

this is set to 255, the sharpness function will be applied to its fullest

extent.

1.4 Negative AI film parameter edit
ColorGenius includes a function that allows it to change images scanned

in from negative films to their equivalent positive images. The

characteristics of negative film vary by the maker and film type, and

therefore different conversion parameter values must be used for each .

ColorGenius already includes parameter settings for 7 commonly

available types of negative film, as well as a more generic set of

parameters. You can change the existing parameter value sets or create

new ones as necessary.

Grayscale image input
Registering variations for a film type

First of all, photograph a paper gray scale using the film you wish to

register. Scan the resulting image and make the necessary settings. When

photographing the image, try to reproduce the conditions used in taking

actual images you will later need to scan; if images are taken outdoors,

photograph the gray scale outdoors in the same kind of weather, or

reproduce the studio lighting used indoors.

Scanner input

Next, scan the film with the image of the paper gray scale. Make sure that

the film includes an orange mask (area with no image).
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Input conditions:

Scan the image under the following conditions

Input mode: 8-bit RGB

Optical resolution: 200 dpi

Magnification: 100%

Input original type: Transparency

Finish: Not used

The optical resolution indicated above is sufficient. If the resolution is too

high, variations caused by small differences in the film granules may

appear, making it difficult to get correct values. Also be sure to open up

the manual setup command palette and make sure that all the setup

commands are off.

Measuring the RGB values for the paper gray scale

Once scanning is complete, the input image’s image window (negative

image) is displayed. Measure the paper gray scales white, black, and mid-

tone gray patch RGB values.

Since the image is a negative, white and black are reversed. The patch

that looks black is actually white and the patch that looks white is actually

black. Determine the RGB values for these two patches, as well as the

mid-tone gray patch 6 away from the white patch, using the information

palette. Note the values for future reference.

In order to compensate for any moire generated when the image was

taken, or for variations in the film granules, check as many points as

possible and use the average value for each group of points.

White Mid-tone gray   Black
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Measure the RGB value for the orange mask area

Next, measure the RGB values for an unexposed area (orange mask). You

can use a section of the film which was not exposed, or the area around

the perforation as the orange mask.

Setting characteristic data
Now we will register the RGB values you acquired in the last few steps

using the “Negative AI films parameter edit” function.

1) From the “File” menu, choose the “Setup environment” sub-menu

under “Preferences”.

2) Click the “Negative film AI parameter” button, and the “Negative AI

film parameter editing” dialog will appear.

Register the characteristic data

Characteristic data for each film is registered in the NegaAIParameter File.

The contents of this file are loaded when the Negative AI film parameter

is launched, and the dialog box containing a list of registered file names

appears.  You can change the data registered, or register new sets of data

for film that is not included as one of the defaults.

1) To change film data that is already registered, select your intended

film and modify whatever parameters are necessary.

2) Input the white, mid-tone gray, and black patch RGB values in the

HL, mid-tone, and SD areas.

3) Input the RGB values for the orange mask.
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Note For a single film, the paper gray scale’s white, mid-tone gray,

and black RGB values, along with the orange mask RGB

values, should have the following relationship:

White values < Mid-tone gray values < Black values < Orange

mask values

If the values do not relate in this way, an error will occur when

you click on Save.

4) Input the saturation value (Default: 100, 0 to 100)

There is normally no need to set this value. When negative/positive

conversion is done, the image tone may be too high in some cases

after conversion. If this occurs, set the saturation value to below 100.

5) Input the Tone RGB value (Default: 0, -10 to 10)

There is normally no need to set this value. Use it if you want to

brighten the mid-tones when converting from negative to positive

images. The higher the value, the brighter the mid-tones after

conversion.

6) Input the overexp. adjustment value (Default: 15, 0 to 20)

When strobe lighting has been used to photograph an object and the

image is overexposed, the resulting positive film’s highlight may

have a yellow cast. To reduce this cast, set this parameter. The

default is 15. To increase the effect, set the value above 15; to reduce

the effect, set it below 15.

7) Click on “Save”. This returns you to the registration of negative film

dialog box. To add other film types or edit more of the existing types,

repeat the same procedures.

8) When all the settings have been made, click on “Close”.  The

following dialog box appears.

Note When converting negative images to positive images,

ColorGenius uses a parameter file called

“NegaAIParameterFile”. If you wish to make changes but also

want to keep the old file data, change the old data file’s name

and use the name “NegaAIParameterFile” for the new file.
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1.5 Sharpness customization
This function adjusts sharpness effects (gain, graininess, mask size,

White/black) depending on the magnification and resolution settings.

From the “File” menu, choose the “Setup customize” sub-menu under

“Preferences”.

Registering a new table:

1) Click the “Register” button.

2) Select image, mode and original type, enter a table name, then click

the “Register” button.

3) Select an item you wish to change, such as “Gain”, “Graininess”,

“Mask size”,“White/black”.

4) Set a value for “Resolution” and “Shift”, and click the “Apply”

button.  The shift value will be displayed in the graph and the

resolution value in the “Registered resolution” field.

Select an item you
wish to change.

Select a
registered table.
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5) If you want to delete the resolution registered in the “Registered

resolution” field, select the resolution you wish to delete and click

the “Delete” button.

6) Click the “End” button.

Note If “0” is set in the “Shift” field, the sharpness effect for the

selected resolution will not be modified.

The resolution value in this dialog is equal to “magnification”

multiplied by “resolution”.

Modifying a registered table

1) Select a registered table you wish to modify.

2) Modify the settings using the same procedure noted in steps 3) to 5)

for new table registration.  After setting modifications are all

completed, click the “End” button.

Deleting a registered table

Select a registered dictionary you wish to delete, and click the “Delete”

button.

1.6 Learning function
When the learning function is activated, the settings in the “Easy setup:

Fine adjustment” dialog are recorded in a dictionary file, to learn

frequently used settings and affect the setup.

Click the button shown in the figure below, and the “Learning settings”

dialog will appear.

Displays the dictionary
currently in use.



Chapter 4 Utilizing convenient functions

4 - 11

Activating the learning function:

Checking the “Use learning mode” check box activates the learning

function.

Selecting a learning mode:

There are two learning modes, as shown in the following list.

Manual learning ............. When the mode selection area in the “Learning

settings” dialog is as shown in the upper left

figure, when the “Apply” button is clicked in

the “Easy setup: Fine adjust” dialog box, setup

contents are accumulated (learned).  When it is

as shown in the lower left figure, learning is

completed and the recorded data affects the

setup value.

Displays the dictionary
currently in use.



ColorGenius EX USERS MANUAL

4 - 12

Automatic learning ......... The setup contents are recorded when the

“Apply” button is clicked in the “Easy setup:

Fine adjust” dialog box, and the data affects the

setup value.

Creating and deleting the dictionary:

Only the “BasicDict” is included as the dictionary setting for software

from the factory.  To create a new dictionary, click the “Register” button.

To delete a registered dictionary, select the dictionary you want to delete

in the “Dictionary list” and click the “Delete” button.

Selecting the dictionary:

To select a dictionary, double-click a dictionary name in the “Dictionary

list”.
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2. Recall setup and apply recipe
With the use of the “recall setup” command, you can read previously used

setup parameters.

After completing the setup and reopening the file, you found that the

current image doesn’t have the desired sharpness, but you want to

reproduce the previous setup commands excluding sharpness.  In such a

case, with the “recall setup” command, you can read and apply the

previous setup parameters to the image, and then modify only the

sharpness as you desire.

Also, with the use of “Apply recipe” command, you can read and use the

previous setup parameters, resolution, and output profile settings.

Note If you execute the “Apply Recipe” command for images

opened from files, only the setup parameters will be applied.

2.1 About the recipe file
After registering the image file to the server, a recipe file in which the

setup parameters, resolution, magnification and output profile are

contained is created.  The recipe file is created in the “Recipe” folder in

the “ColorGenius” folder of the client computer with its name as follows.

“Base file name” designated in the “Output settings” dialog.

The extension for recipe files

“Counter number” designated in the “Output settings” dialog.
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2.2 Recalling the previous setup with recipe file
To recall and apply the previous setup parameters, implement the

following procedures.

1) Set the original, which you want to set up again, in the FT-S5500,

and then implement the prescanning.

2) Click on “Confirm” after specifying the trimming area, and display

the Edit window.

3) Select the “Recall setup” in the “Manual fine adjustment”.

4) Details of the recipe folder appear. Select the recipe file created when

set up the previous image.

5) Click on “Open”

Parameters indicated in the setup palette change to those in the

previous setup.

6) Modify the settings of the parameters as you desire, and then register

such parameters to the server following the usual setup procedures.

Note If you modify the color mode of the image to be output, be

sure that the data of the “Max/Min” set in the previous setup

parameters are cleared.

2.3 Applying the previous recipe
To recall and apply the previous setup parameters, resolution,

magnification, and output profile, implement the following procedures.

1) Set the original, which you want to set up again, in the FT-S5500,

and then implement prescanning.
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2) Click on “Confirm” after specifying the trimming area, and display

the Edit window.

3) Select “Apply Recipe” from the Image menu.

4) Details of the recipe folder appear.  Select the recipe file created

when the previous image was setup.

5) Click on “Open”.

Parameters indicated in the setup palette change to those of the

previous setup.

6) Modify the parameter settings as you desire, and then register them

to the server following the usual setup procedures.

Note If you modify the color mode of the image to be output, be

sure that the “Max/Min” data set in the previous setup’s

parameters are cleared.
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3. Modifying a selected color
You can change a color that you select into another color. In addition, you

can brighten or darken the finish of a selected color by making its tone

curve steep or gentle.

Modifies the
selected color tone. Selected color tone box

Modifies the selected
color to your desired
color.

Selected color
Color after modification

Selected color box

Effective area appears
in white.

Linked with the buttons for line-up display and
for overlap in the edit window.

Enlarges/reduces, scrolls or samples an image.
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3.1 Tone change
1) Choose “Selected color modification” from under the “Image” menu.

2) Checkmark the “Use selected colors tone” box.

3) Click the selected colors tone box.

4) Select the color you want by clicking it in the Edit window while

holding down the command key. The selected color is then displayed

in the selected color tone box. You can also enter values in the text

boxes on the left.

5) To modify the color tone in the selected color tone box, use the slider

or enter a value in the text box on the right.

6) Press the Apply button to display the modified color tone in the Edit

window.

To store the settings in the file, press the Save button. If you press the

Load button, the selected color modification window will read the

saved setting.

3.2 Color change
1) Choose “Selected color modification” from under the “Image” menu.

2) Checkmark the “Use selected color modification” box.

3) Click a selected color box.

Text box
Text boxSelected color

tone box

Slider

Selected color
box

Text box Text box
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4) Select the color you want by clicking it in the Edit window while

holding down the command key. The selected color is then displayed

in the selected color box. You can also enter values in the text boxes

on the left.

5) To set the color in a selected color box, enter the changed values in

the text boxes on the right.

6) You can set a maximum of four selected colors. Conduct the steps

from 2) to 4) above for each.

7) Press the Apply button to display the modified color in the Edit

window.

To store the settings in the file, press the Save button. If you press the

Load button, the selected color modification window will read the

saved setting.

3.3 Setting the effective area
1) Select the areas from the “Effective area” menu. You can also enter

values in the text boxes.

Click the “Save” button so that the settings for the effective area will

be saved into the “Effective area” menu.

Click the “Delete” button so that the settings for the effective area

will be deleted from the “Effective area” menu.

Note Note that items registered at the factory before shipment

cannot be removed form the “Effective area” menu.



Chapter 4 Utilizing convenient functions

4 - 19

3.4 Enlarging/reducing, scrolling and color picking

Enlarging and reducing

You can use this tool in the same manner as for the Magnifying glass tool

in the tool palette.

Please refer to “Processing images with tools” of “1.4 Setup essentials” in

Chapter 3.

Scrolling

If the Magnifying glass tool is used while you are holding down the

command key, the cursor will change to a hand shape. Dragging an image

with this cursor allows you to scroll the image.

Color picking

You can use this tool in the same manner as for the Color picker tool in

the tool palette.

Please refer to “Processing images with tools” of “1.4 Setup essentials” in

Chapter 3.

 Magnifying glass tool

Color picker tool
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4.Reuse of the RGB images
You can store the scanned RGB images that have not been processed

(before setup) and the recipe files in the local storages (simple database),

and reuse the stored RGB images.

Note Set up the server assistant environment before implementing

the above operation by referring to “Server assistant

environment” in Chapter 2 “Operation environmental settings”.

4.1 Saving in the local storage
The following explains the procedure to store the scanned RGB images

that have not been processed (before setup) in the local storages.

1) Referring to Chapter 3 “Understanding basic setup procedures”, set

the setup parameters.

2) Before scanning, select in the setup palette window a method for

storing the RGB images in the local storage. Select the local storage.

3) Select the search keyword.

4) Select the method to store RGB images.



Chapter 4 Utilizing convenient functions

4 - 21

Button Function

Stores the RGB images that have not been

processed (before setup) in the local storages

while processing the images during scanning.

Stores only the RGB images that have not been

processed (before setup) in the local storages.

The processed images are not stored.

Stores no RGB images that have not been

processed (before setup) in the local storage.

5) Click the “Scan” button or the “Register” button in the setup palette

window.

6) Enter a comment and click the “OK” button.

If you do not need any comments, just click the “OK” button.

7) If you clicked the “Register” button in step 5), click the “Start”

button. The calculation starts in the server.

Store the

original image

during scanning

Store the RGB

images only

Store no image
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4.2 Search
The following explains the procedure to search for the RGB images to be

reused.

1) From the “File” menu, select the “Reuse the image” sub-menu under

“LocalStorage”.

2) Enter the search condition and click the “Search” button.

Note • When you wish to narrow a search (AND-search), click the

“More choices” button. After entering the advanced search

conditions, click the “Search” button.

• AND-search can be used. OR-search cannot be used.

More choices  Fewer choices
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During a search, a progress bar will appear.

At the same time, the recipe (previously used setup parameters) is sent to

the client.

“Storage search” window will appear.

Displays the information about the selected image.

Displays the category
information about the
selected image for
the local storage.
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4.3 Edit and calculation
1) Select the image to be edited and calculated in “Storage search”

window.

2) Double-click the thumbnail image, or select the thumbnail image and

click the “Start editing” button.

The image is displayed in the window for editing.

Based on the recipe information, the previously used setup

parameters are automatically displayed on the setup palette window.
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3) Referring to Chapter 3 “Understanding basic setup procedures”,

modify the setup parameters.

4) Click the “Scan” button or the “Register” button in the setup palette

window.

5) If you clicked the “Register” button in step 4), click the “Start”

button. The calculation starts in the server.

Note Because of the additional operations (sending the recipe file

and transferring the image file to the shared folder with the

server), the calculation will take more time than usual.

4.4 Deletion and re-registration
The following explains the procedure to delete the image files from the

local storages, and to modify the comments and reregister the image files

in the local storages.

To delete the image file from the local storage:

1) Referring to “5.2 Search”, search for the image file.

The “Storage search” window will appear.

2) Select the thumbnail image.

3) Click the “Delete from storage” button.
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To modify the comment and reregister the image file in the local

storage:

1) Referring to “5.2 Search”, search for the image file.

The “Storage search” window will appear.

2) Select the thumbnail image.

3) Click the “Reregister in storage” button.

4. 5 Local storage maintenance
When a list of images previously registered in the local storage is

displayed on screen, the following operations are possible, as is the

addition or modification of the keywords already registered in the storage.

• Confirmation of the registered information

• Deletion of unnecessary images

• Modification of comments

1) Startup the Assistant application.

2) Open the environment settings from the file menu.

3) Select a local storage you wish to modify from the “Local storage

setup” list, and click “Modify”.
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4) The maintenance window, which contains the following items, is open.

Stair-shape box Drag and
drop

File button
     Eye icon

Right side box

Description of window

“File button” ............... Opens a dialog for the addition or modification of

a keyword.

“Eye icon” .................. Displays detailed information when clicking a

selected image.

It is also possible to edit comments.

“Stair-shape box” ....... Designates the order of data expansion for

browsing images.

The conditions of data expansion can be dragged

from the box located and dropped in the stair-

shape box. According to the order of conditions

specified (from the top), the classified images are

displayed.

“Right side box” ......... Displays a list of images.

When you click  for the corresponding data

name, the image will be expanded according to the

conditions specified. The thumbnail image and its

file name of the selected item are displayed.
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5) Input the expansion conditions in the stair-shape box, and click  for

the data name in the box to the right to display the corresponding

image. (If no condition is specified in the stair-shape box, all the

images organized by its input device will be displayed).

a) To delete image ............ Select from the list an image you wish

to delete and press the DEL key.

b) To rewrite comment ..... Select an image you wish to rewrite

and click the “eye” icon. When the

detailed information of the selected

image is displayed on screen, rewrite

the comments.

6) When all the steps described above have been completed, click the

close box to close the maintenance window.

Note Once this operation is performed, the operation of the

assistant application is stopped, and the connection between

the server and client applications is disconnected.

Restart procedure

1) Terminate the assistant application and restart.

2) Disconnect the server connection in the client application and then

reconnect it.
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5. Hot folder
You can perform image processing automatically (automatic batch

process) by just dragging and dropping an image file onto the folder

designated as a hot folder. The following explains the procedure.

Note • Set up the server assistant environment before implementing

the above operation by referring to “Server assistant

environment” in Chapter 2 “Operation environmental settings”.

• In the Mac OS X environment, after opening the privilege

window, select “Read & Write” for files and folders in the pop

up menu for users who are logged into the Macintosh.

1) Start up the server assistant, server application and client application

(following the order as described here).

2) Drag and drop the image onto the hot folder following any procedure

described below in the Finder.

• Drag and drop the image file only.

• Drag and drop the folder that contains the “image file” and the

“recipe file”.

• Drag and drop the folder that contains the “image file that is

embedded in the ICC profile” and the “destination file”.
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If an error occurs and the process fails, the files are moved to

“ErrorFolder”.

During the calculation, the Server Management palette is as shown below.

When the calculation is completed normally, the image file is output to

the output destination folder.
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6. Opening all image files in a folder at once
The following explains the procedure to open all image files in a folder at

once (folder open function) and process the image files.

Note Set up the server assistant environment before implementing

the above operation by referring to “Server assistant

environment” in Chapter 2 “Operation environmental settings”.

To open all image files at once:

The following explains the procedure to open all image files in a folder at

once and display them in “Folder search” window.

1) Start up the server assistant, server application and client application

(following the order as described here).

2) Select “Open the images in the folder...” from the “File” menu.

3) Select the folder and click the “Select” button.

4) “Folder search” window will appear.

Displays the information about
the selected image.
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To edit and calculate the image file:

The following explains the procedure to edit and calculate the image files.

1) Double-click the thumbnail image in “Folder search” window, or

select the thumbnail image and click the “Start editing” button.

The image is displayed in the window for editing.
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2) Referring to Chapter 3 “Understanding basic setup procedures”,

modify the setup parameters.

3) Click the “Scan” button or the “Register” button in the setup palette

window.

4) If you clicked the “Register” button in step 3), click the “Start”

button. The calculation starts in the server.

To register the image file in the local storage:

The following explains the procedure to register the image files in the

local storage. Registering the image files in the local storage enables you

to reuse the image files. (Refer to “4. Reuse of the RGB images”.)

1) In “Folder search” window, after activating the “Select” button under

the image you wish to register in the local storage, click the “Register

in storage” button.

Select button
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Displays a checkmark under the thumbnail image after completing

registration.

Check mark
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7. Example usage of hot folder and folder open function
If you use a hot folder and the folder open function simultaneously, you

can implement the “automatic batch process + fine adjustment process”

flow.

This flow is useful in the cases described below.

To use with a general-purpose database:

The following is an example of when it is used with a general-purpose

database. Refer to the figure shown below.

1) Transfer the RGB image files (before setup) to the database from the

FT-S5500.

2) Sort the image files into two groups: one group for fine adjustment

and one group to be batch processed automatically.

3) Move the files to be batch processed automatically to the hot folder.

4) Move the files requiring fine adjustment to the destination folder.

5) Fine-adjust the files after using the folder open function.

Refer to “6. Opening all image files in a folder at once”.

FT-S5500

RGB image that has not been processed

When image files 
are required to be 
reused 
(fine adjustment process)

When image files 
are required to be 
reused 
(automatic batch process)

Database

To destination 
folder

To hot folder

Folder open function Automatic batch process
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6) The files are batch processed automatically.

Refer to “5. Hot folder”.

To use with digital camera:

The following illustrates image processing in ColorGenius whereby

images are imported from a digital camera.

Note An ICC profile for digital camera is required for the above.

1) Sort the image files into unnecessary image files, image files

requiring fine adjustment and image files to be batch processed

automatically.

2) Drag the unnecessary image files to the Trash.

3) Move the files to be batch processed automatically to the hot folder.

4) Move the files requiring fine adjustment to the destination folder.

5) Fine-adjust the files using the folder open function.

Refer to “6. Opening all image files in a folder at once”.

6) The files are batch processed automatically.

Refer to “5. Hot folder”.

Sort the image 
files on the browser.

Digital camera

Unnecessary image files

Image files 
requiring fine 
adjustment

Image files to be 
batch processed 
automatically

To Trash. To destination 
folder.

To hot folder.

Fine-adjust using 
the folder open function.
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For the 4 X 5 inch
original

6 X 6 cm (6 X 7 cm)

35 mm

35 mm - slides

8. Scanning using the optional compound tray
By using the optional compound tray set, you can implement the scanning

of multiple originals (regular form) effectively.

Note As for the procedures for setting the original in the holder and

setting the holder in the compound tray, refer to the manual

supplied with the optional compound tray for details.

8.1 About the compound tray set
The following trays and holders are included in the optional compound

tray set.

Compound tray

The compound tray is a tray which is used with the glassless holder or the

plastic holder.  The compound tray is used by taking off the standard

glass tray from the FT-S5500.

Glassless holder

The glassless holder is a holder used when scanning the original in

medium or low resolutions.  There are 4 original size options for the

holders.
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35 mm For the 4 X 56 X 7 cminch original

Plastic holder

The plastic holder is a holder which allows you to put the original

between transparent plastic covers.  By using the exclusive mask sheets

(for the plastic holder), you can set the original in 4 X 5 inch, 6 X 7 cm or

35 mm sizes.  The plastic holder is used for scanning in full resolution.

Mask sheets for plastic holder

Exclusive mask sheets are used for setting the original in the plastic

holder.  Holes on the mask sheet allow you to align the original simply by

placing the holes on the pins on the plastic holder.

8.2 Scanning using the compound tray
1) Set the original in either the plastic holder or the glassless holder.

2) Remove the standard tray from the FT-S5500, and then mount the

optional compound tray.  The compound tray has its own mounting

directions, right and left.  The side on which a notch is made, should

be placed on the right.  Be sure not to mount the tray in the reverse.
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Notch

3) Set the holder, in which the original has been set in 1. above on the

compound tray.  The holder shall be set matching the triangle notches

with the corresponding triangle protrusions on the tray.

4) Close the top cover, and then start prescanning.

The Prescan window appears after completing the prescanning.

The FT-S5500 has the ability to recognize the position of the input

originals automatically and reproduce them in the display in the same

position.  Dotted lines indicating the trimming area appear around the

input images (except when "Auto Trimming enable" is not check-

marked on the "General" tab in the "FT-S5500 Option" window).

Note There are windows on the top and left sides of the glassless

holder.  These windows are used to detect the orientation of

the holder and the size/position/direction of the original

accurately.

5) Hereafter, implement the setup operations following the usual setup

procedures.

End of Chapter 4
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Chapter 5 Using the Make Profile Tool

Note The Make Profile Tool on the Mac OS X can be operated

within the classic environment.

Output profile making tool
When outputting an image from ColorGenius, it is also necessary to

convert the image into data that matches the individual printer and

printing conditions.  The output profile making tool will create the mode

conversion profile using the ICC profile supplied with the scanner.  You

can also create a output profile by modifying the conversion data with

which the image has already been converted.

1. The Output profile making tool
Double-click the “Make Profile” icon, located in the folder where

ColorGenius was installed.  This tool creates ColorGenius conversion

profiles (Output profiles), which are used to convert image data that was

set up in ColorGenius from CMYK to RGB and so on. ColorGenius

profiles are in file format. Therefore, the user can generate and save

several different profiles. Profiles are available for use once they are

placed in the ColorGenius Profile folder. Furthermore, a single file can

contain more than one profile.*   Each contains an RGB/RGB conversion

table, an RGB/CMYK conversion table, and an RGB/Grayscale

conversion table. This tool allows you to make each of those types of

profiles.

Note A single file can contain 5 profiles (for transparent originals,

reflective originals, negative color originals, printed materials,

water color and a default for other originals).  The profile for

default is applied to the original if there is no specific profile for it.

You can create profiles two different ways, as indicated below.

• Use a ColorSync profile

This allows you to create RGB/RGB and RGB/CMYK conversion tables.

• Edit an existing profile

This allows you to create RGB/RGB, RGB/CMYK, and RGB/

Grayscale conversion tables.
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Creating a profile using a ColorSync profile
If you already have a ColorSync version 2 profile for the printer you will

use for output, you can alter that profile to create a ColorGenius

conversion profile. ICC profiles include two profiles, which link the RGB

and CMYK levels generated by scanners and printers with measured

colors. To create a ColorGenius RGB/RGB conversion profile, simply

combine the scanner and monitor profiles. For an RGB/CMYK

conversion profile, a scanner profile and a printer profile are required.

With this application, you can generate a ColorGenius input profile using

an existing ColorSync profile. You can not create a ColorSync profile. If

you want to generate ColorGenius profiles using ColorSync profiles,

ColorSync V2 must be installed in your system.

1) Select “Convert from ICC profile” in the Make menu.

2) A dialog box is displayed. Check the RGB output table of the CMYK

output table as necessary for the table you will create.

3) When you click the ICC profile (scanner) menu, you can select a

profile to use. Select “StdRGB (Scanner)”. To create an RGB output

profile, select a monitor profile as well. To create a CMYK output

profile, select the printer or printing press profile required.

4) After indicating the tables to be generated, make the other profile

generation settings. If you are generating a new profile, select

“New”. To change an existing profile, select “Change”. A dialog box

is displayed. If you are generating a new profile, input the name and

folder for the file. If you are editing a profile, select the profile you

wish to alter.
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If you are editing an existing profile, only the tables whose check

boxes are checked will be changed. Tables whose check boxes are

not checked will not be changed. If you are generating a new profile

but have only selected one table, a default will be generated for the

other automatically.

When creating a CMYK profile, the range of 0 to 100% dot is

automatically increased.  Click the "Set Range" button when you

wish to designate the increased range.  The "Set Range" dialog

appears in which you can designate the range.

5) If you click on “Convert”, the dialog box for the profiles contained in

the file to be converted appears.

If you want to change the profile, select the profile from the menu,

and enter a new profile name.  Clicking on “Make Profile” will

enable you to change the parameters of the profile.
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To edit an existing profile
You can generate a conversion table that includes changes to the tone

curve or a color correction applied after the data is converted to CMYK

by ColorGenius.

The output profile making tool can change an existing profile or make a

new profile.

Note A single profile contains various conversion tables for

transparent originals, reflective originals, negative color

originals or printed materials.

Therefore, although you can make a thoroughly new

conversion profile, we recommend that you change only the

required tables in a copy of an attached profile.

The procedure for editing an existing profile is as follows.

• Scan an RGB image from the FT-S5500 after applying AI Setup and

Sharpness.

• Add a patch to the scanned RGB TIFF image.

• Convert the RGB image to an CMYK image with the ColorGenius for

the finished image that you desire.

• Create an RGB/CMYK output profile using a ColorGenius tool which

reads the dot percentage in the patch areas of both the RGB image and

the CMYK image.

1) Scan an RGB image from the FT-S5500 after applying AI Setup and

Sharpness.

Make an 8 bit RGB image after applying the AI and Sharpness

processes with the Manual setup of the ColorGenius.

The Sharpness function is considered to have no relationship with the

color adjustment, however, since it may cause a dullness of color, it

should be applied in this step.

Note The Easy setup (Intelligent setup) is not suitable for CMYK

conversion in the subsequent process because it sets the

most appropriate setting for RGB output.

Store the RGB image processed by the ColorGenius in the

TIFF format.



Chapter 5 Using the Make Profile Tool

5 - 5

2) Add a patch to the scanned RGB TIFF image.

Start the Make Profile Tool and select "PROFILE", an output profile

making tool.

Select "Add patch to TIFF Image" from the "Make" menu and select

the scanned RGB TIFF image.

Note This process adds the information for creating a profile to the

RGB image.  Note that it causes an unidentifiable image to

appear on the top side of the image and this is not caused by

an error.

3) Convert the RGB image to an CMYK image by the ColorGenius for

the finished image you desire.

In the manual fine adjust of the ColorGenius, adjust the color

functions such as Max/Min setting, Color correction, or Tone

correction, so that the image to be converted to an CMYK image

results in an appropriate printing with suitable color reproduction.

Then convert the RGB image to an CMYK image and store it.

Note Although you can perform the above adjustment in another

application, the standard dot percentage for the highlight or

shadow points may differ from that of the FT-S5500.  For

example, a setting to avoid a change of the dot percentage for

the highlight and shadow points is required.

Do not apply the AI and Sharpness functions here because

they have already been applied to the image.

Store the CMYK image in the TIFF format.
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When creating an RGB/Gray scale conversion profile, set so that the

converted image becomes a gray scale image.  When creating an

RGB/RGB conversion profile, set so that the RGB output image

results in the most appropriate printing.

4) Select “Convert from patched TIFF” from the “Make” menu.  The

“Make output profile” dialog appears.

5) Check the “Make CMYK output profile” check box on the top side

of the dialog, and select an CMYK TIFF image file to be read.  The

characteristics of the RGB/CMYK conversion are read.

6) Click the “Change” button and select an existing profile you wish to

edit.

Clicking the “New” button makes a new profile.

Note If you want to set the value for the dot range increase, click

the “Set Range” button and designate the value you wish.

Even if the value is not set here, the dot range increase is

automatically done with the current set value or default value

(if the value has not been changed yet).
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7) Click the “Make” button and select the kind of original to which the

conversion characteristics can be applied.

Note A single profile contains various conversion tables for

transparent originals, reflective originals, negative color

originals or printed materials.  One original type to which the

conversion characteristics can be applied must be selected

before they are written in the profile.

8) Input a profile name and store it.

The profile name is displayed in the right bottom side of the

Calibration palette.  Click the “Make” button to write the conversion

characteristics in the profile.

This completes the procedure for writing characteristics concerning

the tone or color correction in a conversion profile.  These

characteristics can then be used by selecting the output profile in the

Setup palette window or “Merge Profile” from the “Environment”

menu.

End of Chapter 5
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Chapter 6 Line Art

ColorGenius allows you to input line art originals from the FT-S5500.

The originals can be transparent media (films, etc.) or reflective media

(mechanicals, etc.).

If you select “Line art” from the “Original” menu, you must start by

setting up ColorGenius with the “FT-S5500 Options” dialog box.  This is

different from the procedure for other originals.

1.  Prescanning
1) Set the original to the scanner.

2) Select “Line art [Ref]” or “Line art [Trn]” from the “Original” menu.

Note It is recommended that you select “Line Art [Mechanicals] if

you use mechanicals as an original.

3) Click the “Prescan” button.

The prescanning starts.  The display of the prescanned image

indicates the completion of the pre-scanning operation.

4) Set the trimming area in the Prescan Window.

The procedures for trimming and designating the prescanning area

are the same as for other types of originals.

5) Click on the “Reso.” box in the setup palette, and then input the

desired resolution setting using numerical keys.

6) Click on the “Mag.” box in the setup palette, and then input the

desired magnification setting using numerical keys.
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2.  Line art controls
1) Click the “Setting expand” button in the setup palette window.

2) Click the “Line art” tab.

Preview in full resolution
The prescanned image is displayed in the upper left corner of the window.

A partial area of the prescanned image can be previewed in the actually

entered resolution (i.e. the “Reso” resolution setting multiplied by the

magnification factor entered in the setup palette).  The line art controls to

be used for scanning can be set while using this previewed image.

To set the optical resolution:

Select the optical resolution to be applied for the scanning, from the

“Optical Resolution” pull-down menu.

Note The set optical resolution will be used during the FT-S5500’s

full-resolution scan of an original.  You can select a desired

optical resolution from among the 2000 dpi, 1200 dpi and

600 dpi settings.  The following tables shows the prominent

characteristics of each optical resolution.

Optical resolution Scanning time Fine detail 
reproduction quality

Number of scan passes for full 
tray table

 600 dpi �� Rapid�� Low�� Once��

 1200 dpi�� Moderate�� Moderate�� Twice��

 2000 dpi�� Slow�� High�� Four times
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Indicates the
preview image.

Indicates the
prescanned image.

To set the partial preview area:

The small box appearing at the center of the prescanned image is the area

that can be previewed in full resolution.  Placing the cursor inside the

image changes the shape of the cursor (hand shape) to enable the hand

tool.  You can scroll up/down the prescanned image by dragging this hand

tool.  By placing the cursor on the small box and dragging it, you can

move the partial preview area.

Starting the preview:

Click the “Preview” button after setting the resolution and partial preview

area.  The prescanning starts with the set resolution.

To undo the preview:

You can undo the preview settings if you feel the selected preview area or

the selected resolution is not appropriate.

By clicking the “Show Overview” radio button under the “Preview”

button, the prescanned image reappears in place of the preview image on

the monitor.  During this display, you can set the preview area again, and

then click the “Preview” button.

Note If you are operating ColorGenius in a multi-client/server

environment, while an image is being scanned upon another

client’s request, the overview image may not be displayed on

your screen.

Even if the above occurs, you still can set the line art controls.

If you wish to preview the image in full resolution, be sure to

display the overview image on your window by clicking the

“Overview” button before previewing.
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Setting the input controls
When the prescreening is completed, the preview image is displayed in

place of the prescreened image.  The input controls can be set while

monitoring the preview image.

1) Select the filter to be used for scanning, from the “Channel” pull-

down menu.

If any corrections have been made with a red pen on the original in

black, and if the “Red” filter is selected from the menu, ColorGenius

will allow the image to be input, while sorting out the portions in red,

during the scanning.

2) Set the appropriate sharpness level in the image by moving the

sharpness slider.  Moving the slider to the left/right gives a

simulation of the image.

3) When you scan the halftone tint, there will be a moire.  Checking the

“Moire Erasing” box will allow you to eliminate the moire on the

image.  By moving the moire removal slider, you can adjust the

degree of moire erasing.

Note Increasing the degree of moire erasing too much will result in

a deterioration of the character clarity in the image.

4) While monitoring the preview image, set the threshold level, which

discriminates between white and black sections of line art, to an

appropriate value by moving the threshold slider.

5) Click the “OK” button, and then close the “FT-S5500 Options”

dialog box.
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Note • If a start&stop occurs during scanning with the FT-S5500,

click the “Scan speed” tab, and then activate “Adjust

automatically the scan speed at line art/DotFinder.”

• Automatic control of the scanning speed is not possible with

the “Scan speed” tab in the FT-S5000.
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3.  Server registration
After the input controls have been set, register the controls in the server in

the same way as in the normal setup registration procedure.

1) Designate the scanning area with the Trimming tool.

2) Perform the output setting procedure.

3) Perform the registration operations in the server.

When the batch process is deactivated (off), the scanning starts.

When the batch process is activated (on), click the “Start” button to

start the scanning.

After completion of the scanning, the image is registered to its output

destination with its designated file name.

Note If any additional operation is implemented on the host

computer while inputting an image via the FT-S5500, it will

lower the transmission speed of the image data to the host

computer and temporarily halt the scanning by the FT-S5500

while it waits for the host computer to complete reading the

image data (start & stop function).  If this “start & stop

function” occurs while inputting line art from the FT-S5500,

this can result in unevenness in some portion of the image.

To avoid this, please do not implement any additional

operation on the host computer while inputting line art.
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